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DS-530 II/DS-575W II/DS-770 Il User's Guide

Welcome to the DS-530 1I/DS-575W [I/DS-770 Il User's Guide.
For a printable PDF copy of this guide, click here.

Note: Availability of products in this guide varies by country.



Product Basics

See these sections to learn about the basic features of your product.

Product Parts Locations

User Replaceable Epson Scanner Parts
Changing the Power Off and Sleep Timer Settings
Using the Epson Smart Panel Mobile App

Product Parts Locations

See these sections to identify the parts on your product.

Scanner Parts
Scanner Buttons and Lights

Parent topic: Product Basics
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Scanner Parts

Note: The illustrations show the DS-575W II, but the parts are the same for the DS-530 Il and DS-770 II.

ADF (Automatic Document Feeder)
Edge guides

Input tray

Input tray extension

Output tray

oo OB WN -

Output tray extensions
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Stopper

7

A

Kensington security slot

USB 3.0 port
Power inlet

1

2
3
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1 Cover open lever
2  Scanner cover

3 Pickup rollers
4

Separation rollers

1 AC adapter
2 Power cord
3 USB 3.0 cable

Parent topic: Product Parts Locations
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Scanner Buttons and Lights

Buttons
DS-530 II/DS-770 1

b e
] ) 7 \ Oo| =2 -
- I» o
C © -
\
X ] @ _
1 O power button
2 = double feed detection skip button
3 J» slow mode button
4 @ stop button
5 < start button
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DS-575W I
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O power button

<« Wi-Fi connect button

2 Wi-Fi button

= double feed detection skip button
> slow mode button

@ stop button

<& start button
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Lights
DS-530 1/DS-770 Il

O 6 6

'@ O |

rm
[T
7
v I&v—‘

! error light

@ automatic feeding mode light
O ready light

= double feed detection skip light
J> slow mode light

a A W N =
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DS-575W II
O 6 6 0 06

“Zp AP mode light

= Wi-Fi light

! error light

W automatic feeding mode light
O ready light

= double feed detection skip light

N O o AW DN

> slow mode light
Parent topic: Product Parts Locations

User Replaceable Epson Scanner Parts

U.S. and Canada: You can purchase optional accessories and replacement parts at epson.com (U.S.
sales) or epson.ca (Canadian sales). You can also purchase accessories from an Epson authorized
reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in
Canada.

Latin America: You can purchase optional accessories and replacement parts from an Epson
authorized reseller. To find the nearest reseller, go to latin.epson.com. Or you can contact your nearest
sales office as described in "Where to Get Help".

17


https://www.epson.com
https://www.epson.ca
http://latin.epson.com

Note: Availability of accessories varies by country.

Part Part number
Carrier sheet (5) B12B819051
Roller assembly kit B12B819671
Cleaning kit B12B819291
Flatbed scanner dock (DS-530 II/DS-770-| B12B819011
[l only)

Epson Perfection V19 (for use with B11B231201
scanner dock)

Epson Perfection V39 (for use with B11B232201
scanner dock)

Parent topic: Product Basics

Related references
Where to Get Help (U.S. and Canada)
Where to Get Help (Latin America)

Changing the Power Off and Sleep Timer Settings

You can use the Epson Scan 2 Utility to change the time period before the scanner enters sleep mode
and turns off automatically.

Note: The Power Off and Sleep Timer settings may not be available when you connect to the scanner
over a network (DS-575W II).

1. Do one of the following to access the Epson Scan 2 Utility:

* Windows 11: Click , then search for Epson Scan 2 Utility and select it.

* Windows 10: Click E and select EPSON > Epson Scan 2 Utility.
* Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

+ Windows (other versions): Click ﬂ' or Start, and select All Programs or Programs. Select
EPSON > Epson Scan 2 > Epson Scan 2 Utility.

18



* Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2
Utility.

Click the Power Save tab.

E Epson Scan 2 Uhality =

Scanwwr ;| EPSON w

information Counter |Power Save | Mantenance Adjustments  Scanver Settng  Other

-

Slesp Timer (rinwtes) : | 10 -

Power OFf Temer (minutes)
AT power or AC adapter 1 | OFf

Direct Power On : | OFf v

17

Select the length of time after which you want the scanner to go to sleep as the Sleep Timer setting.

Select the length of time after which you want the scanner to automatically turn off when not in use
as the Power Off Timer setting.

Select the length of time after which you want the scanner to automatically turn off when not in use
as the AC power or AC adapter setting. You can also turn off the timer.

Turn on the Direct Power On setting if you want the scanner to turn on when it is connected to the
power source, without pressing the power button.

Click Set to save the settings.

19



8.

Close the Epson Scan 2 Utility.

Parent topic: Product Basics

Using the Epson Smart Panel Mobile App
Use this free Apple and Android app to scan with networked Epson products (DS-575W II).

Note: Epson Smart Panel does not support scanning with a carrier sheet or scanning for originals that
are 15.5 inches (393.8 mm) or longer.

3,
4.
5,

Connect your product to your wireless network. See the link below.

Visit epson.com/connect (U.S.), epson.ca/connect (Canada), or latin.epson.com/connect (Latin
America) to learn more about Epson Smart Panel and check the compatibility of your mobile device.

Download Epson Smart Panel from the Apple App Store or Google Play.
Connect your mobile device to the same wireless network as your product.
Open Epson Smart Panel and select your Epson product, if necessary.

Now you are ready to scan with your mobile device and your Epson product.

Parent topic: Product Basics

Related tasks
Setting Up Network Scanning
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https://www.epson.com/connect
https://www.epson.ca/connect
https://latin.epson.com/connect

Loading Originals

Follow the instructions here to load your originals into the product.

Note: The illustrations show the DS-575W Il, but the steps are the same for the DS-530 Il and DS-770 Il.

Loading Originals in the Input Tray
Loading Plastic and Laminated Cards in the Input Tray
Loading Special Originals

Loading Originals in the Input Tray

You can load originals that meet the document specifications in the input tray.

Caution: Do not load photos, valuable original documents or artwork, directly into the input tray. This
may wrinkle or damage the original. Load these originals using an optional carrier sheet.

Note: Photos scanned using a document scanner may not have the same color depth as the original.
Use a flatbed photo scanner with the optional flatbed scanner dock (DS-530 11/DS-770 Il) to achieve the
best color reproduction of photos.

The steps below describe loading originals of the same size. To load originals of multiple sizes at once,
see the link at the end of these steps.

1. Open the input tray and pull up its extension.

21



2. Pull out the output tray and its extension, and open the stopper.

Note: If you are loading an original that is 15.5 inches (393.8 mm) or longer, do not pull out the input
or output tray extensions and do not open the stopper.

3. Slide the input tray edge guides all the way out.

22



4. If you are loading a multi-page original, fan your stack of originals.

Note: If you are loading an original that is 15.5 inches (393.8 mm) or longer, load only one sheet at a
time.

)/

5. Stack the originals with the printed side facing down and slide the stack so the leading edge is at an
angle as shown.

23



6. Load standard originals into the input tray printed side down and top edge first, and guide them in
until they meet resistance.

7

+ If you are loading paper business cards, load up to 15 (DS-530 II/DS-575W II) or 30 (DS-770 II)
cards printed side down and long edge first into the input tray horizontally, and slide them in until
they meet resistance.

24






+ If you are loading hole-punched originals, load them with the holes facing down or to the side as
shown. The holes must be within 1.2 inches (30 mm) of the edge of the originals.

7

~
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Note: If you are scanning originals that are 15.5 inches (393.8 mm) or longer, support the original as
it enters into and ejects from the scanner as shown.

If necessary during scanning, adjust the position of the stopper on the output tray extension to fit the
ejected originals.

Note: If thicker paper does not eject properly or falls from the output tray, push in the output tray and
allow the originals to eject freely onto the surface below the scanner. If the scanned images are
affected by the originals ejecting below the scanner, try placing the scanner on the edge of a table
where the ejected originals can drop freely.

27



If scanning thin or wrinkled paper causes paper jams, press the I» slow mode button once before
scanning to slow down the feeding speed; press it again to return to normal speed.

If a paper feed error is detected, the Paper Protection feature stops the scanning process automatically
to reduce damage to the original. To change the Paper Protection detection level, open the Epson Scan
2 Utility, click on the Scanner Setting tab, and select the desired level from the Paper Protection drop-
down list.

Note: The Paper Protection feature does not prevent all documents from being damaged. Paper feed
errors may not be detected depending on the paper feeding conditions.

Loading Multiple Sizes of Originals in the Input Tray
Original Document Specifications

Parent topic: Loading Originals

Related references
Original Document Specifications

Related topics
Scanning

Loading Multiple Sizes of Originals in the Input Tray

You can load originals of different sizes, paper types, and thicknesses at one time in the input tray. Just
make sure they meet the original document specifications.

28



Caution: Do not load photos, or valuable original documents or artwork, directly into the input tray. This
may wrinkle or damage the original. Load these originals using an optional carrier sheet.

Note: Photos scanned using a document scanner may not have the same color depth as the original.

Use a flatbed photo scanner with the optional flatbed scanner dock (DS-530 11/DS-770 Il) to achieve the
best color reproduction of photos.

1. Open the input tray and pull up its extension.
2. Pull out the output tray and its extension, and open the stopper.

Note: If you are loading originals that are 15.5 inches (393.8 mm) or longer, do not pull out the input
or output tray extensions and do not open the stopper.

29



3. Slide the input tray edge guides all the way out.

4. Load the originals in the input tray in descending order of paper size with the widest at the back and
the narrowest at the front. Slide them in until they meet resistance. Make sure the printed sides are
facedown and the top edges are slightly angled in the input tray.

7

[
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5. Slide the edge guides against the edges of the widest original.

6. If necessary during scanning, adjust the position of the stopper on the output tray extension to fit the
ejected originals.

Note: If thicker paper does not eject properly or falls from the output tray, push in the output tray and
allow the originals to eject freely onto the surface below the scanner. If the scanned images are
affected by the originals ejecting below the scanner, try placing the scanner on the edge of a table
where the ejected originals can drop freely.

If scanning thin or wrinkled paper causes paper jams, press the I» slow mode button once before
scanning to slow down the feeding speed; press it again to return to normal speed.

Parent topic: Loading Originals in the Input Tray

Related topics
Scanning

Original Document Specifications
You can load original documents that meet these specifications in your scanner.
DS-530 II/DS-575W lI
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Paper type Paper size Paper weight Loading capacity
Plain paper Letter (8.5 x 11 inches 7t01101b 21 1b (80 g/m?): 50 sheets
2
Fine paper [216 x 279 mm]) (27 t0 413 g/m?) 24 1b (90 g/m?): 43 sheets
Legal (8.5 x 14 inches 2.
Recycled paper [216 x 356 mm]) iﬁelzt(; 04 g/m?): 37
A4 (8.3 x 11.7 inches 2).
[210 x 297 mm]) gﬁ;gt(;w g/m?): 31
[148 x 210 mm)) 3210 (157 g/m’):
A6 (4.1 x 5.8 inches 56 Ib (209 a/m?3): 19
[105 x 148 mm]) o8 Ib (209 g/m’)
B5 (7.2 x 10.1 inches 68 Ib (256 g/m?): 15
[182 x 257 mm]) sheets
B6 (5 x 7.2 inches 110 Ib (413 g/m?): 9
[128 x 182 mm]) sheets
A8 (21 X 29 inCheS 34 to 110 Ib Loading Capacity may
[52 x 74 mm]) (127 to 413 g/m*) | vary depending on the
paper type.
Paper business cards |Business cards Upto 56 Ib 15 cards loaded
(210 g/m?) horizontally

DS-770 11
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Paper type Paper size Paper weight Loading capacity
Plain paper Letter (8.5 x 11 inches 7t0o1101b 21 1b (80 g/m?): 100
Fine paper [216 x 279 mm]) (27 to 413 g/m?) sheets
A4 (8.3 x 11.7 inches 24 1b (90 g/m?): 86 sheets
Recycled paper [210 x 297 mm]) 26 Ib (104 gm?): 74
A5 (5.8 x 8.2 inches sheets
[148 x 210 mm]) 34 1b (127 g/m?): 62
A6 (4.1 x 5.8 inches sheets
[105 x 148 mm]) 42 1b (157 g/m?): 50
B5 (7.2 x 10.1 inches sheets
[182 x 257 mm]) 56 Ib (209 g/m?): 38
B6 (5 x 7.2 inches sheets
[128 x 182 mm]) 68 Ib (256 g/m?): 30
A8 (2.1 x 2.9 inches 34t0 110 1b sheets
[52 x 74 mm]) (12710413 9/m*) 1110 1b (413 gim?): 18

sheets

Loading capacity may
vary depending on the
paper type.
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Paper type

Paper size

Paper weight

Loading capacity

Plain paper
Fine paper
Recycled paper

Legal (8.5 x 14 inches
[216 x 356 mm])

7t0o1101b
(27 to 413 g/m?)

21 1b (80 g/m?): 80 sheets
24 1b (90 g/m?): 69 sheets
28 1b (104 g/m?): 59
sheets

34 1b (127 g/m?): 50
sheets

42 1b (157 g/m?): 40
sheets

56 Ib (209 g/m?): 30
sheets

68 Ib (256 g/m?): 24
sheets

1101b (413 g/m3?): 14
sheets

Paper business cards

Business cards

Upto561b
(210 g/m?)

30 cards loaded
horizontally

Note: You can load originals of different sizes, paper types, and thicknesses up to this size: Letter
(8.5 x 11 inches [216 x 279 mm]).

The following types of originals may not be successfully scanned or may require special attention:

» Originals with uneven surfaces, such as embossed documents or letterhead

» Originals with wrinkles or fold lines

» Perforated originals

+ Originals with labels or stickers

» Carbonless paper
» Curled originals
» Coated paper

Note: Lightly wrinkled paper may scan better if you slow down the feeding speed during scanning or
smooth out the wrinkles before loading. Use a carrier sheet to scan delicate originals or originals that are
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easily wrinkled. To scan originals that are incorrectly detected as double feeds, press the = double feed
detection skip button before scanning, or set the Detect Double Feed setting to Off on the Main Settings
tab in the Epson Scan 2 window.

Caution: Do not load the following types of originals directly in the scanner, or they may be damaged or
may damage the scanner:

* Photos

* Originals that are bound

» Passports

* Thermal paper

» Fabric or other non-paper originals

» Originals containing staples or paper clips
+ Originals with wet ink or glue

* Ripped originals

» Heavily wrinkled or curled originals

+ Originals with holes on the bottom of them
» Transparencies

 Originals with carbon paper backing

+ Originals with sticky notes attached

* Glossy originals

Note: Photos scanned using a document scanner may not have the same color depth as the original.
Use a flatbed photo scanner with the optional flatbed scanner dock (DS-530 1I/DS-770 II) to achieve the
best color reproduction of photos.

Parent topic: Loading Originals in the Input Tray

Loading Plastic and Laminated Cards in the Input Tray

You can load plastic and laminated cards that meet the card specifications in the input tray.
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1. Open the input tray, pull out the output tray, and open the stopper. Do not pull out the extensions.
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3. Load plastic or laminated cards printed side down and long edge first into the input tray horizontally,
and slide them in until they meet resistance.

( )
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rds vert

Note: Do not load plastic ca




4. Slide the edge guides against the edges of the card.

5. Turn off the Detect Double Feed setting on the Main Settings tab in Epson Scan 2 when scanning
the cards.

Note: If you do not disable the Detect Double Feed setting and a double feed error occurs, remove
the plastic or laminated card from the input tray and reload it. Press the = double feed detection skip
button to disable the Detect Double Feed feature and scan again.
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Plastic and Laminated Card Specifications

Parent topic: Loading Originals

Related references

Plastic and Laminated Card Specifications

Related topics
Scanning

Plastic and Laminated Card Specifications

You can load original plastic and laminated cards that meet these specifications in your scanner.

Paper type

Paper size

Paper thickness

Loading capacity

Plastic cards,
embossed (ISO781A
ID-1 compliant)

Plastic cards, standard
(ISO781A ID-1
compliant)

2.1 x 3.3 inches
(54 x 85.6 mm)

0.05inch (1.24 mm)
maximum

1 card (horizontal)

0.03 inch (0.76 mm)
maximum

5 cards (horizontal)

Laminated cards

4.7 x 5.9 inches (120 x
150 mm) or smaller

0.03 inch (0.8 mm)
maximum

1 card

Note: Plastic cards with glossy surfaces may not scan properly.

Parent topic: Loading Plastic and Laminated Cards in the Input Tray

Loading Special Originals

You can load a photo or large, thick, or folded original in the input tray using one or more carrier sheets.
You can also load envelopes. Make sure the originals meet the specifications for special originals before

loading them.

1. Open the input tray and pull up its extension.
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2. Pull out the output tray and its extension, and open the stopper.

Note: If you are loading originals that are 15.5 inches (393.8 mm) or longer, do not pull out the input
or output tray extensions and do not open the stopper.

3. Slide the input tray edge guides all the way out.
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4. Load envelopes vertically in the input tray with the printable side down and the flap facing as shown.
Slide in the envelopes until they meet resistance.

g S
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5. Do one of the following to load a photo, or folded or irregularly shaped originals:

» For a Letter- or A4-size or larger original, fold it as shown and place it in the center of an optional
carrier sheet. Make sure the illustration on the front edge of the carrier sheet is facing up.

Z L * (¢

» For a photo or an irregularly shaped original, load it in the center of an optional carrier sheet with
the printed side face down. Make sure the illustration on the front edge of the carrier sheet is
facing up.

abc

=

Note: Photos scanned using a document scanner may not have the same color depth as the
original. Use a flatbed photo scanner with the optional flatbed scanner dock (DS-530 11/DS-770 Il) to
achieve the best color reproduction of photos.
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6. Load the carrier sheet in the input tray as shown until it meets resistance.
Folded original

BPESY

c

=+ ]

7
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Photo or irregularly shaped original

_\g _Q_

7

8. Turn off the Detect Double Feed setting on the Main Settings tab in Epson Scan 2 when scanning
special originals.
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9. If necessary during scanning, adjust the position of the stopper on the output tray extension to fit the
ejected originals.

Note: If thicker paper does not eject properly or falls from the output tray, push in the output tray and
allow the originals to eject freely onto the surface below the scanner. If the scanned images are
affected by the originals ejecting below the scanner, try placing the scanner on the edge of a table
where the ejected originals can drop freely.

Special Original Specifications
Parent topic: Loading Originals

Related references
Special Original Specifications

Related topics
Scanning

Special Original Specifications

You can load photos, envelopes, or large, thick, or folded originals that meet these specifications in your
scanner.

Note: Photos scanned using a document scanner may not have the same color depth as the original.
Use a flatbed photo scanner with the optional flatbed scanner dock (DS-530 11/DS-770 Il) to achieve the
best color reproduction of photos.

Paper type Paper size Paper thickness Loading capacity
Large originals (plain | Up to this size: A3 (11.7 x 16.5 [ 0.012 inch (0.3 mm) | DS-530 II/DS-575W II:
paper, fine paper, or |inches [297 x 420 mm]) maximum 5 carrier sheets
recycled paper) (excluding the DS-770 II: 10 carrier
(load only in a carrier thickness of the carrier | sheets
sheet) sheet)
Photos Up to this size: A4 (8.3 x 11.7 [0.012inch (0.3 mm) | DS-530 II/DS-575W II:
(load only in a carrier inches [210 x 297 mm]) maximum 5 carrier sheets
sheet) (excluding the DS-770 1I: 10 carrier
thickness of the carrier | sheets
sheet)
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Paper type

Paper size

Paper thickness

Loading capacity

Envelopes

4.49 x 6.38 inches (114 x
162 mm)

4.33 x 8.66 inches (110 x
220 mm)

0.015 inch (0.38 mm)
maximum

DS-530 1I/DS-575W II:
5 envelopes

DS-77011: 10
envelopes

Irregularly shaped
originals

(load only in a carrier
sheet)

Up to this size: A4 (8.3 x 11.7
inches [210 x 297 mm])

0.012inch (0.3 mm)
maximum

(excluding the
thickness of the carrier
sheet)

DS-530 II/DS-575W II:
5 carrier sheets

DS-770 1l: 10 carrier
sheets

Note: Originals that are wider than 8.5 inches (215.9 mm) need to be folded in half. The leading edge of
originals approximately 11.7 inches (297 mm) long must be placed at the binding part of the carrier
sheet. Otherwise, the length of the scanned image may be longer than intended as the scanner scans to
the end of the carrier sheet when you select Auto Detect as the Document Size setting in the scanning

software.

Parent topic: Loading Special Originals
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Wi-Fi Networking

See these sections to use your scanner over a Wi-Fi network (DS-575W II).

Network Security Recommendations

Connecting to an Existing Wi-Fi Network

Setting Up Wireless Scanning from a Smart Device Using Epson Smart Panel
Direct Wi-Fi Mode (AP Mode) Setup

Wi-Fi Protected Setup (WPS)

Setting Up Network Scanning

Disabling Wi-Fi Features

Restoring Default Network Settings

Network Security Recommendations

To help deter unauthorized access to your product over a network, you should protect your network
environment using appropriate security measures.

Security measures such as these can help deter threats such as loss of user data, use of telephone and
fax lines, and other intrusions:

* Enable security on your wireless LAN

Enable the appropriate security on the wireless LAN you plan to use with your product. Network
security such as a network password can deter interception of traffic over the wireless LAN. Your
router may already have a default password enabled by your Internet service provider (ISP). See your
ISP and router documentation for instructions on how to change the default password and better
secure your network.

* Connect your product only to a network protected by a firewall

Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead,
connect it to a router or other network connection protected by a firewall. Your router may already
have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best
results, set up and use a private IP address for your network connection.

* Change the default administrator password on your product

If your product has an option to set an administrator password, change the default administrator
password to deter access by unauthorized users to personal data stored on your product, such as IDs,
passwords, and contact lists.

Parent topic: Wi-Fi Networking
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Connecting to an Existing Wi-Fi Network

You can set up your product to communicate with your computer using a wireless router. The wireless
router can be connected to your computer over a wireless or wired network.

Epson product

Wireless router

Computer with a wireless interface
Computer

Internet

oo o0~ WDN -

Ethernet cable (used only for wired connection to the wireless router)

Manually Connecting to a Wi-Fi Network
Parent topic: Wi-Fi Networking
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Manually Connecting to a Wi-Fi Network

You can manually connect the scanner to a Wi-Fi network by entering the network names (SSIDs) and
passwords for your wireless network router and scanner. You must have a computer with a wireless
adapter to set up the connection. Also make sure you have installed the scanner software as described
on the scanner Start Here sheet.

Note: For best results, re-install your scanner software and follow the on-screen instructions to connect
to a network.

Make a note of the SSID and password shown on the label on the back of the scanner.
Turn on the scanner.
Press the = Wi-Fi button on the scanner's control panel.

oo nh =~

From your computer or device, open the list of wireless networks and select the SSID shown on the
scanner label. Then select the connect option.

5. Enter the password shown on the scanner label.
The Zap AP mode light comes on in blue, indicating an AP mode connection.
6. Connect your computer or device to the wireless network.

Wait for the = Wi-Fi light on the scanner to stop flashing and stay on, indicating that the scanner is
connected to the network.

7. Select the link below to set up network scanning. You must set up network scanning to connect your
computer and wireless scanner.

Parent topic: Connecting to an Existing Wi-Fi Network

Related tasks
Setting Up Network Scanning

Setting Up Wireless Scanning from a Smart Device Using Epson Smart

Panel

You can use the Epson Smart Panel app to connect your Epson product to a wireless network or
connect your smart device directly to the product. Epson Smart Panel is available on iOS and Android
devices.

Make sure you have the following:
« A device that is connected to a wireless network
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* The Epson Smart Panel app installed on the device
* The wireless network name (SSID) and password
1. Make sure the product is turned on and is ready to scan.

Note: You must perform initial setup before setting up wireless scanning.

2. Open the Epson Smart Panel app on your device.
3. Do one of the following:

+ If the app automatically recognizes the product, follow the on-screen instructions to set up the
wireless connection.

+ If the app does not automatically recognize the product, select the + icon and continue with the
next step.

4. On the next screen, select Connect to a New Product.
5. Select your product from the list.

Note: If your product is not listed, move closer to the product and try again. If the product is still not
shown, connect your scanner to the wireless network again and then select Connect to Existing
Product in the Epson Smart Panel app and follow the on-screen instructions. See the link below for
wireless setup instructions.

6. Select Next to select the current wireless network.

Note: If you want to connect the product to a different wireless network, select Change another Wi-
Fi SSID.

7. Enter the password for the wireless network and select OK.
The app starts configuring the product.

Your product is now connected to a wireless network and set up for use with the Epson Smart Panel
app.

Parent topic: Wi-Fi Networking

Related tasks

Using the Epson Smart Panel Mobile App

Starting a Scan from a Smartphone or Tablet
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Direct Wi-Fi Mode (AP Mode) Setup

You can set up your scanner to communicate directly with your computer or another device without
requiring a wireless router. If your product is not already connected to a wireless network, it enters
access point mode and the scanner itself acts as the network access point for up to 4 devices.

=== [*)

JJJ
1) \

1 Epson scanner
2  Computer with a wireless interface
3  Other wireless devices

Note: Devices directly connected to the scanner cannot communicate with each other through the
scanner.

Enabling a Direct Wi-Fi (AP Mode) Connection
Using WPS to Set Up a Direct Wi-Fi Connection

Parent topic: Wi-Fi Networking
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Enabling a Direct Wi-Fi (AP Mode) Connection

You can enable a direct Wi-Fi connection to allow direct communication between your scanner and
computer or other devices without a wireless router or access point.

Note: If you are connecting a wireless device to the scanner using a direct Wi-Fi (AP mode) connection,
the scanner is connected to the same Wi-Fi network (SSID) as the wireless device. When you turn off
the scanner, the wireless device is automatically connected to other Wi-Fi networks, so you must
reconnect to the scanner in AP mode from the wireless device when you turn the scanner back on. To
avoid reconnecting every time you turn the scanner off and back on, connect the scanner to an access
point instead.

oo nh =~

Make a note of the SSID and password shown on the label on the back of the scanner.
Open the scanner's input tray.
=

Press the "= Wi-Fi button on the scanner's control panel.

From your computer or device, search for and select the SSID shown on the label on the back of the
scanner.

Enter the password shown on the label on the back of the scanner.

The Za» AP mode light lights up in blue indicating an AP mode connection. If the connection is
unsuccessful, make sure you entered the password correctly.

Parent topic: Direct Wi-Fi Mode (AP Mode) Setup

Using WPS to Set Up a Direct Wi-Fi Connection

You can use Wi-Fi Protected Setup (WPS) to create a direct Wi-Fi connection to a WPS-enabled
computer or device.

1.

Press the WPS button on your computer or device, or enable the WPS feature.
The computer or device enters standby mode for WPS connection for 2 minutes.

Press and hold the @ Wi-Fi connect button on the scanner for at least 3 seconds, then release it
when the = Wi-Fi light flashes blue.

When the = Wi-Fi light on the scanner stays on, the connection is established.

Parent topic: Direct Wi-Fi Mode (AP Mode) Setup
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Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router, you can quickly connect your product to the
network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router. If there is
no hardware button, there may be a WPS setting in the software for the device. Check your network
product documentation for details.

Using WPS to Connect to a Network
Using WPS PIN Mode to Connect to a Network

Parent topic: Wi-Fi Networking

Using WPS to Connect to a Network

If you have a WPS-enabled wireless router, you can use Wi-Fi Protected Setup (WPS) to connect your
scanner to the network. Make sure you have installed your scanner software as described on your
scanner Start Here sheet.

Note: For best results, re-install your scanner software and follow the on-screen instructions to connect
to a network.

Open the scanner's input tray.

2. Enable WPS on your router by pressing and holding the WPS button on your wireless router until the
security light flashes or by enabling the WPS setting in your router firmware.

The router enters WPS discovery mode for 2 minutes.

Note: If you cannot locate the WPS button, or there are no buttons on the router or access point, see
the documentation provided with your router for details.

3. Press and hold the @ Wi-Fi connect button on the scanner for at least 3 seconds, then release it
when the = Wi-Fi light flashes blue.

Note: If you do not complete this step within 2 minutes, repeat steps 1 through 3.

The = Wi-Fi and 7 AP mode lights flash alternately while establishing the connection. When the
= Wi-Fi light on the scanner stays on, the scanner is connected to the network.
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Note: If the ! error light turns on, the connection failed. Press the @ stop button to clear the error,
restart the scanner and router, and repeat these steps.

Select the link below to set up network scanner. You must set up network scanning to connect your
computer and wireless scanner.

Parent topic: Wi-Fi Protected Setup (WPS)

Related tasks
Setting Up Network Scanning

Using WPS PIN Mode to Connect to a Network

If you have a WPS-enabled wireless router that supports PIN mode, you can use Wi-Fi Protected Setup
(WPS) PIN mode to connect your scanner to the network.

1.
2.

Open the scanner's input tray.
Press and hold the = Wi-Fi button and the @ Wi-Fi connect button on the scanner simultaneously

>

for at least three seconds, then release them when the "= Wi-Fi light flashes blue.
Note: The scanner enters discovery mode for 2 minutes.

Use your computer to enter the PIN code 01234565 into the WPS PIN number setting in the wireless
router within 2 minutes.

Note: If you do not enter the code within 2 minutes, repeat steps 1 through 3.

The = Wi-Fi and 7 AP mode lights flash alternately while establishing the connection. When the
2 Wi-Fi light on the scanner stays on, the scanner is connected to the network.

Note: If the ! error light turns on, the connection failed. Press the & stop button to clear the error,
restart the router, and repeat these steps.

Select the link below to set up network scanning. You must set up network scanning to connect your
computer and wireless scanner.

Parent topic: Wi-Fi Protected Setup (WPS)

Related tasks
Setting Up Network Scanning
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Setting Up Network Scanning
You can set up network scanning to your product through a direct connection to your product.

First, manually configure your product to connect to your network. Then follow the instructions here to
set up your computer for network scanning using the Epson Scan 2 Utility. Your product must be turned
on and connected to the network.

Note: Make a note of the IP address or host name of the product so you can enter it in these steps.

1. Do one of the following to start the Epson Scan 2 Utility:

* Windows 11: Click , then search for Epson Scan 2 Utility and select it.

* Windows 10: Click E > EPSON > Epson Scan 2 Utility.
* Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

* Windows 7: Click © - All Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility.

* Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility.
2. Select Settings from the Scanner drop-down list.

You see a screen like this:

Loanner Settimgs w
Moarme el CommectonAddress
s (2] L]
A Refresh
(7 o] | con

Note: If you see an Enable Editing button (Windows) or the lock icon (Mac), click it so that you can
modify the product settings.
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3. Select your product and click Add.
You see a screen like this:

Add Netwoark Scanner i

Model : | EFSON e

Mame @ | Metwork 01

() Saarch for Natwork 1:'],

Address

() Enter address

(2] ; Cancel

4. Do one of the following:
» Under Search for Network, select the IP address of your Epson product and click Add.

+ Select the Enter address setting, type in the IP address or host name of your Epson product, and
click Add.

5. Click OK to check the connection.
You see a confirmation message.
6. Click OK to save your settings and close the Epson Scan 2 Utility.
Determining the Scanner's IP Address
Parent topic: Wi-Fi Networking
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Determining the Scanner's IP Address

If you have multiple scanners on your network, you need to know the IP address of the scanner when
setting up network scanning.

1. Do one of the following to start EpsonNet Config:

* Windows 11: Click , then search for EpsonNet Config and select it.

* Windows 10: Click E > EpsonNet > EpsonNet Config.
* Windows 8.x: Navigate to the Apps screen and select EpsonNet Config.

* Windows (other versions): Click ﬂ' or Start, and select All Programs or Programs. Select
EpsonNet > EpsonNet Config > EpsonNet Config.

* Mac: Open the Applications folder and select Epson Software > EpsonNet > EpsonNet Config
> EpsonNet Config.

2. Locate your scanner in the list and write down the IP address.
Parent topic: Setting Up Network Scanning

Disabling Wi-Fi Features
You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for Epson DocumentScan.

Press and hold the = Wi-Fi button on the scanner for at least three seconds to disable the Wi-Fi
features. When the = Wi-Fi light and the Za» AP mode light turn off, Wi-Fi is disabled.

Parent topic: Wi-Fi Networking

Restoring Default Network Settings

If you need to solve a problem with your network connection, you can restore all network settings to their
defaults.

1. Turn off your scanner.

2. Press and hold the & Wi-Fi button and the O power button until the = Wi-Fi and ZAp AP mode
lights turn on. Then release the buttons.
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3. Wait until the = Wi-Fi and Z& AP mode lights flash alternately and then turn off.
The default network settings are restored.
Parent topic: Wi-Fi Networking
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Scanning

You can scan your originals and save them as digital files.

Note: Your product may differ from the images in this guide, but the instructions are the same unless
otherwise noted.

Starting a Scan

Scanning with Simple Scan in Document Capture Pro - Windows
Scanning with Job Scan in Document Capture Pro - Windows
Scanning with Document Capture - Mac

Scanning in Epson Scan 2

Scan Resolution Guidelines

Scanning Special Projects

Starting a Scan

After placing your originals on your product for scanning, start scanning using one of these methods.
Note: You can also scan using Document Capture Pro (Windows) or Document Capture (Mac).

Starting a Scan from a Scanner Button
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Starting a Scan from a Smartphone or Tablet

Parent topic: Scanning

Starting a Scan from a Scanner Button

You can scan using the <> start button on your scanner. This automatically starts Document Capture Pro
(Windows) or Document Capture (Mac) and the scan job you have assigned to the button.

Note: Make sure Epson Scan 2 and either Document Capture Pro (Windows) or Document Capture
(Mac) are installed on the computer connected to the scanner. Document Capture Pro (Windows) and
Document Capture (Mac) do not support scanning from the <> start button on your scanner over a
wireless network (DS-575W II). Launch Epson Scan 2 before scanning from the <> start button on your
scanner.
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1. Make sure the scanner is connected to your computer or network.
. Load an original in your scanner.
3. Press the & start button.

The scanner starts the job that was assigned to the <> start button in Document Capture Pro
(Windows) or Document Capture (Mac).

Note: You can view or change the scan settings using Document Capture Pro (Windows) or
Document Capture (Mac).

Note: If your scanner is connected to one computer via USB and another computer via wireless,
pressing the < start button on the scanner will save the scanned images to the wirelessly connected
computer (DS-575W 1I).

Adding and Assigning Scan Jobs with Document Capture Pro - Windows
Assigning Start Button Settings or Scan Jobs - Mac

Parent topic: Starting a Scan

Related topics
Loading Originals

Adding and Assigning Scan Jobs with Document Capture Pro - Windows

You can view, change, or add available default scan settings when you scan using the < start button on
your product or the Job Scan option in Document Capture Pro. You do this by accessing the scan jobs in
the Document Capture Pro program.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
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2. Select the Job Scan tab.
You see a window like this:

[ T———

Document Capture Pro

™ DN

3. Click the Job Settings button.
You see a window like this:

[ —————

Document Capture Pro

4. To add a scan job, click the New Job icon.
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Enter a name for the new job, and select any settings as necessary from the following options:

Scan: select the size, color, or resolution

Save: select the file name, file type, or destination folder

Index: enable the index setting and choose output options for an index file

Send: select the destination for the scanned file, or choose to email or print the file

Confirm/Test: select the job button icon and color, choose display settings, and run a test scan if
necessary

Click Save when you are finished.

The new job appears in the Job Scan window.

To assign a scan job to the <> start button on your product, click the Button Assignment icon.
You see a screen like this:

Baficn Agriman n
=

Job Mamar - Soa ' s pa  Dastngtios
B ety iz PO = A & 5 dadernd’istes Dortery D00cien POF Open Folder
m Coatom Soan - ADE - Double-paded/'Ruto Detect 0cp FOF Cppn Foicer
D Auns Sean « ADF « Sangiedaded’'farts Detoct T00den LN Open Folder

o e

» il
i
- Cancel
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8. Select the job that you want to assign to the <> start button using any of the pull-down menus.

Note: The number of pull-down menus available may vary, depending on your product and any
connected options.

Click OK, then click Back.
You can now use the added scan jobs when you scan from the < start button on your product.

Parent topic: Starting a Scan from a Scanner Button
Assigning Start Button Settings or Scan Jobs - Mac

You can view or change the default scan settings when you scan using the <> start button on your
scanner. You do this by accessing the scan jobs in the Document Capture program.

Note: Document Capture (Mac) does not support scanning from the <> start button on your scanner over
a wireless network (DS-575W I1). Launch Epson Scan 2 before scanning from the <> start button on your
scanner.

1.

2.

Start Document Capture on a computer connected to the product.

Click the Manage Job icon from the toolbar at the top of the window.
You see a window showing the current scan job list.

If you want to add a scan job, click Add or the + icon, enter a name for the new job, select settings
as necessary, and click OK.

You can now use the new scan job when you scan with Document Capture.

Note: See the Help information in Document Capture for details.

If you want to assign a scan job to the <> start button, click the % * icon at the bottom of the
window and click Event Settings.
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5. Select the job that you want to assign to the < start button.

Solect the action 1o be bwnchad when tha buttion I§ prossed.

SO0 MNET

Start Butlan | Scan to POF

concel (LN

6. Click OK.
Parent topic: Starting a Scan from a Scanner Button

Starting a Scan Using the Epson Scan 2 Icon

You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a
file.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software

from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

* Windows 11: Click , then search for Epson Scan 2 and select it.

* Windows 10: Click E and select EPSON > Epson Scan 2.
* Windows 8.x: Navigate to the Apps screen and select Epson Scan 2.
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* Windows (other versions): Click E]' or Start, and select All Programs or Programs. Select EPSON
> Epson Scan 2 > Epson Scan 2.

* Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.
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You see an Epson Scan 2 window like this:

EEpﬁnnS{anz - o X
Scanner : |EPSU'\I v]
Scan Settings : | Default Setting v|
Main Settings  Advanced Settings
Document Source : | ADF v|
[ Automatic Feeding Mode
Scanning Side : | Double-Sided v|
Dacument Size : | Auto Detect | '__JI [
Image Type : | Black & White v
Resohtion : do
Stitch Images : | Off v]
Rotate : |0° v]
Correct Document Skew : | Paper Skew v |
[[] add or edit pages after scanning
Skip Blank Pages : |CrFI' vI
Detect Double Feed : | On v|
Image Format : [ ppF ~|
FieName © | img20190116_17044938.pdf ~|
Folder : | pocuments ~|
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Parent topic: Starting a Scan

Starting a Scan from a Scanning Program

You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan,
and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software

from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; not all scan functions will be available.
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You see an Epson Scan 2 window like this:

E Epson Scan 2 - o

Scanner : |EPSU\I

Scan Settings : | Default Setting

Main Settings  Advanced Settings

Document Source : | ADF v|
[ Automatic Feeding Mode

Scanning Side : | Double-Sided |

Document Size : | Auto Detect ~| I |i‘5

Image Type : | Black & White v]

Resoluton o

Stitch Images : | Off v|

Rotate : | 0° v|

Correct Document Skew : | Paper Skew v|
[J Add or edit pages after scanning

Skip Blank Pages : | Off v|

Detect Double Feed : | On v|

Image Format : |p|;|:

FieName : | img20150116_17044938.pdf

Folder : |Dm.lmnﬁ

12 e | presen || san
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Parent topic: Starting a Scan

Starting a Scan from a Smartphone or Tablet

You can use the Epson Smart Panel app to scan from a network scanner to an iOS or Android device
over a direct Wi-Fi connection (DS-575W II).

Note: Epson Smart Panel does not support scanning with a carrier sheet, or scanning originals longer
than 15.5 inches (393.7 mm).

1. Download the Epson Smart Panel app from your device's app store or from Epson's website. See
the link below.

2. Place your original on the product for scanning.

3. Open the Epson Smart Panel app and select a scan menu on the home screen.
4. Follow the on-screen instructions to scan and save your original.

Parent topic: Starting a Scan

Related tasks
Using the Epson Smart Panel Mobile App

Scanning with Simple Scan in Document Capture Pro - Windows

You can use the Simple Scan option in Document Capture Pro to quickly scan an original.

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

Load your original in the product.
2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click Iﬂ and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
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Note: Add and select your product in the Epson Scan 2 Scanner Settings list, if necessary. Open
Epson Scan 2, then select Settings from the Scanner drop-down list.

3. Select the Simple Scan tab.
You see a window like this:

(]

T

Document Capture Pro

B

4. Select the size of your original from the Document Size menu.

5. If you want to change specific settings for the scan, click the Scan Settings button. Change any of
the settings as necessary and click OK. For additional settings, click the Detailed Settings button
on the Scan Settings screen.

6. Do one of the following:
» To scan the front side of an original, select SCAN single-sided.
» To scan both sides of an original, select SCAN double-sided.
Your product scans the original and the image appears in the Edit Scanned Results window.
7. Review and edit the scanned image as necessary and click Next when you are finished.
8. Select a destination for the scanned image, change any settings as necessary, and click Complete.

Note: If you are sending the scanned image to a server or cloud destination, you need to enter your
login information.

Parent topic: Scanning
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Related tasks
Scanning in Epson Scan 2

Related topics
Loading Originals

Scanning with Job Scan in Document Capture Pro - Windows

You can create scan jobs in Document Capture Pro and use them to quickly scan originals and save
them to various destinations.

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

Load your original in the product.
2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
Note: You may need to select your scanner from the list, if necessary.

3. Select the Job Scan tab.
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You see a window like this:

Document Capture Pro

57 .
_ Sk

4. Select one of the scan jobs (or click Job Settings to create a new scan job).
The product scans the loaded original and saves it according to the job settings.

5. Depending on the settings for the scan job you selected, you may be able to view and edit the pages
before saving them. If so, click Complete when finished.

The scanned image is saved according to the job settings.
Parent topic: Scanning

Related tasks
Scanning in Epson Scan 2

Related topics
Loading Originals

Scanning with Document Capture - Mac

When you scan with Document Capture, the program automatically saves your scanned file on your

computer in the folder you specify. You can select settings, preview, and change the scanned file
settings as necessary.

Note: Settings may vary depending on the software version you are using. See the Help menu in
Document Capture at any time for more information.
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1. Load your original in the product.

2. Open the Applications folder, open the Epson Software folder, and select Document Capture.
You see a window like this:

;' ﬁwum E

W

SRR

b

Note: You may need to select your scanner from the scanner list.

3. Click the |§| scan icon.
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You see a window like this:

a Scan Settings

Scanner: EPSON
Source:  ADF
Double-Sided
Document Size:  Letter

e

Image Type: Auto
Rotation:  Mone
Resolution: Low H

(o] o o)

[+ 8

ol
Text Enhancement

Correct Documaent Skew
Skip Blank Page

Show the confirmation dialog after scanning

? Cancel | L

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the 22| Start Job button, and skip the rest of these steps.

Select any displayed scan settings you want to use.
Note: See the Help information in Document Capture for details.

If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.

Click the [2] Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.

Click Scan.
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You see a preview of your scan in the Document Capture window.

;. Eﬁ#-ﬂ:h&l :[.." :T:i:"J .'L 1
aa RSB A%RA
o
¥
&~
Q

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

8. If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.

10. Click one of the destination icons to choose where to send your scanned files. (If you cannot see all
of the icons below, click the arrow next to the icons.) Change any settings as necessary.

oO® 9 06 Y

Note: If you are sending the scanned image to a server or cloud destination, you need to enter your
login information.

11. Depending on the destination you chose, click OK or Send to complete the operation.
Parent topic: Scanning
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Related tasks
Scanning in Epson Scan 2

Related topics
Loading Originals

Scanning in Epson Scan 2

Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document
and save the scanned image in various file formats in your operating system's Documents or My
Documents folder, or open it in your scanning program. You can preview the scanned image and select
or change settings as necessary.

1. Load your original in the product.
2. Start Epson Scan 2.

77



You see this window:

EEpﬁunS«:nnz - o >
Scanner : | EPSON v]
Scan Settings : | Default Setting ]

Main Settings  Advanced Settings

Document Source : | ADF v|
[ Automatic Feeding Mode
Scanning Side : | Double-Sided v|
Decument Size : | Auto Datect v||:"{,||_&,'
Image Type : | Black & White v]
Resokuton : o
Stitch Images : | Off v|
Rotate : | 0° v]
Correct Document Skew : | Paper Skew v |
[J Add or edit pages after scanning
Skip Blank Pages : | Off v]
Detect Double Feed : | On v|
Image Format : [ poF v |
FieName : | img20190116_17044338.pdf |
rote ;. [Doamens 7

78



8.
9.

Note: The Document Source setting is automatically set to ADF for your product.

If you want to scan different size originals by loading them into the ADF one by one, check the
Automatic Feeding Mode checkbox and click Scan. Scanning begins as soon as you load each
original.

Select the Scanning Side setting that matches the sides of the original that you want to scan.

Select the Document Size setting that matches the size of your original, or select Auto Detect to
have Epson Scan 2 automatically detect the size. You can select Customize to enter a custom size,
if necessary.

Click on one of the orientation icons, if applicable.

Select your original image type and how you want it scanned as the Image Type setting, or select
Auto to have Epson Scan 2 automatically detect the image type.

Select the Resolution setting you want to use for your scan.
Select any of the additional settings that you want to use on the Main Settings tab.

10. Click the Advanced Settings tab and select any settings that you want to use.

11. To see a preview of your scan with the settings you selected, click the Preview button.
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Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

Scanned Image
Preview

San Count 1

. Reinsert your original into the ADF.

. If scanning an original in a carrier sheet or other special original, see the link at the end of this
section for other setting requirements for special documents.

. Select the format in which you want to save your scanned file as the Image Format setting. If
necessary, select Options and select any desired format options.

. Select Settings to modify the file name settings. Enter the file name for your scanned file in the File
Name field.
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16. Select the location in which you want to save your scanned file as the Folder setting. If necessary,
select Select to choose an alternate folder or create a new folder.

17. Click Scan.
The product scans your original and saves the scanned file in the location you specified.

18. If you selected the Automatic Feeding Mode setting, place your next original in the ADF for
scanning. When you finish scanning originals, click Finish.

Additional Scanning Settings - Main Settings Tab

Additional Scanning Settings - Advanced Settings Tab

Scanning Settings for Special Documents

Image Format Options

Parent topic: Scanning

Related topics
Loading Originals

Additional Scanning Settings - Main Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Main Settings tab.

Stitch Images
When scanning double-sided originals, lets you lay out images from both sides of the original onto
one scanned page.

Rotate
Rotates the original image clockwise to the desired angle before scanning it. Select Auto to allow
your product to automatically rotate the image based on the orientation of the text (may take longer to
scan).

Correct Document Skew
Corrects skewed originals, image contents, or both.

Add or edit pages after scanning
Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page
order.

Note: To save multiple pages in a single file, you must select a file format that supports multiple
pages such as PDF or Multi-TIFF. If you select another file format, each scanned image or page is
saved as a separate file.
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Skip Blank Pages
If the scanner detects marks from the other side of a blank page and adds the marks to the scanned
image, adjust this setting to prevent this.

Detect Double Feed
Detects a double-feed paper error in the ADF. If you are scanning an original envelope or plastic card,
select Off.

Parent topic: Scanning in Epson Scan 2

Additional Scanning Settings - Advanced Settings Tab

You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.

Remove Background
Removes the background of the originals.

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes black and white images clearer and text recognition more accurate by separating the text from
the graphics.

Dropout
The scan will not pick up the color you select. This setting is available only if you select Grayscale or
Black & White as the Image Type setting.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you
select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
Adjusts the midtone density of the scanned image.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
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Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Remove Punch Holes
Removes the shadows caused by holes on the edges of the original.

Dual Image Output
Scans the original image twice using different output settings (Windows only).

Watermark
Adds text to the background of the scanned image.

Parent topic: Scanning in Epson Scan 2

Scanning Settings for Special Documents
You need to select specific options on the Main Settings tab in Epson Scan 2 when scanning special

originals.

Type of original Required settings

Envelope Select Off as the Detect Double Feed setting.

Plastic cards Select Plastic Card (Landscape) as the Document Size
setting and Off as the Detect Double Feed setting.

Carrier sheet If you select Auto Detect as the Document Size setting,

paper skew is automatically corrected even if the Correct
Document Skew setting is set to Off.

If you select a setting other than Auto Detect as the
Document Size setting, you can only use Contents Skew
as the Correct Document Skew setting. As paper skew is
not applied in this case, only contents skew is corrected
when you select the Paper and Contents Skew setting.
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Type of original Required settings

Large originals If the Document Size list does not contain the document
size you want to scan, select Customize to create a custom
size.

Long paper If the Document Size list does not contain the document

size you want to scan, select Auto Detect (Long Paper) or
select Customize to create a custom document size.

If you are scanning folded originals without the carrier sheet,
select Off as the Detect Double Feed setting.

Laminated cards To scan any transparent areas around the edges of the
card, select Settings as the Document Size setting and
either select the Scan laminated card checkbox or create a
custom size.

Parent topic: Scanning in Epson Scan 2

Image Format Options

You can select different image formats and related options. For details on available options, click the ?
icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.

BITMAP (*.bmp)
A standard image file format for most Windows programs.

JPEG (*.jpg)
An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

PNG (*.png)
An image format that does not lose quality during editing.

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.
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PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.

Searchable PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned
document can be searched.

Note: If you do not see the Searchable PDF option, run the Epson Software Updater and install the
EPSON Scan OCR Component/Pro.

Parent topic: Scanning in Epson Scan 2

Scan Resolution Guidelines

The resolution setting in your scanning software, measured in dpi (dots per inch), controls the amount of
detail captured in your scans. Increasing the resolution raises the amount of detail captured but comes
with the following disadvantages:

* Larger file sizes

* |t takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
* The image may become too large to fit on your display or print on paper

* The maximum length you can scan is reduced

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by the software. Follow these guidelines to determine the
resolution setting you need:

* You will scan the image at its original size but enlarge it later in an image-editing program.

Increase the resolution setting in your scanning software. Increase the resolution by the same amount
you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi
(dots per inch) and you will double the image size later, change the resolution setting to 600 dpi.

* You will scan the image at 100% or smaller size.
Select the resolution setting based on how you will use the scanned image:
» Email/view on a computer screen/post on the web: 96 to 200 dpi
 Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi
* You will scan a long original.
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Scan paper up to 240 inches (6096 mm) in length with a maximum resolution of 300 dpi or less.
Parent topic: Scanning

Scanning Special Projects

Your product's scanning software offers various options to help you quickly complete special scan
projects.

Scanning Two Originals onto One Sheet (Stitching Images) - Windows

Scanning Multi-Page Originals as Separate Files - Windows

Saving Scanned Documents as a Searchable PDF Using Epson Scan 2

Saving Scanned Documents as a Searchable PDF with Document Capture - Mac
Saving a Scan as an Office Format File - Windows

Saving a Scan as an Office Format File - Mac

Scanning to a SharePoint Server or Cloud Service - Windows

Scanning to a SharePoint Server or Cloud Service - Mac

Parent topic: Scanning

Scanning Two Originals onto One Sheet (Stitching Images) - Windows

You can scan both sides of a double-sided or folded original in Document Capture Pro and combine
them into a single image with the Epson Scan 2 Stitch Images setting (not available for all products).

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

1. Load your original in the product.

Note: If an optional carrier sheet is included with your product, use it when scanning a folded original
or damage to the original may occur. Place the original into the carrier sheet with the folded edge
against the right side of the carrier sheet. Make sure to insert the carrier sheet into your product with
the white edge facing down.

2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.
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* Windows (other versions): Click ﬁ or Start and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

3. Select the Simple Scan tab.
You see a window like this:

[ SERESE AT 5Y . B om

Document Capture Pro
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4. Click Scan Settings > Detailed Settings.
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You see an Epson Scan 2 window like this:

E Epson Scan 2 - o

Scanner : |EPSU\I

Scan Settings : | Default Setting

Main Settings  Advanced Settings

Document Source : | ADF v|
[ Automatic Feeding Mode

Scanning Side : | Double-Sided |

Document Size : | Auto Detect ~| I |i‘5

Image Type : | Black & White v]

Resoluton o

Stitch Images : | Off v|

Rotate : | 0° v|

Correct Document Skew : | Paper Skew v|
[J Add or edit pages after scanning

Skip Blank Pages : | Off v|

Detect Double Feed : | On v|

Image Format : |p|;|:

FieName : | img20150116_17044938.pdf

Folder : |Dm.lmnﬁ

12 e | presen || san
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5. Select Double-Sided as the Scanning Side setting.
Select the original document size or Auto Detect as the Document Size setting.
Select one of the following as the Stitch Images setting:
* Top & Bottom: Places the scanned images one above the other.
» Left & Right: Places the scanned images side by side.
8. Select the Advanced Settings tab and verify that the Edge Fill setting is set to None.
9. Click Save.
10. Click OK.
11. Click SCAN double-sided.
Your product scans the original and the image appears in the Edit Scanned Results window.
Note: If the scanned images are not stitched together in the correct orientation, click Scanning Side

on the Epson Scan 2 window, select Settings, set the Binding Edge to Left or Top, and rescan the
document.

12. Review and edit the scanned pages as necessary and click Next when you are finished.
13. Select a destination and any settings as necessary and click Complete.
Parent topic: Scanning Special Projects

Scanning Multi-Page Originals as Separate Files - Windows

You can use Document Capture Pro to scan multi-page originals as separate scanned files. You can
indicate how the separate files are created by defining a maximum page count per file or by inserting
blank pages, barcodes, or characters that can be detected by the software as separation markers.

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

1. Load your multi-page original in the product.
2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click Iﬂ and select Epson Software > Document Capture Pro.
+ Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.
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* Windows (other versions): Click ﬁ or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
Select the Job Scan tab.
You see a window like this:

Document Capture Pro

it - o i

n h -
o

Click the Job Settings button.
You see a window like this:

Document Capture Pro
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5. Select New Job and select the scan settings. Click Next when finished.
You see a window like this:
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Select the Apply job separation checkbox.

Select the method you want to use to separate the originals as the Separator setting. Click
Separation Settings to specify the settings for the selected option.

8. Finish creating the new scan job and click Save.
9. Click Back on the Job Settings screen.

Your originals are saved into separate files and folders as specified when the job is run.
Parent topic: Scanning Special Projects

Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is
recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.

Note: The required Epson Scan 2 OCR Component is installed automatically when you install your
product software. If you install your product software programs individually, be sure to also install this
component if you want to perform OCR.
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10.
11.

12.

Load your original in the product for scanning.

Start Epson Scan 2.

Select your scan settings.

Click Preview and adjust the area you want to scan, if necessary.
Reload the ejected original in the scanner.

Select Searchable PDF as the Image Format setting.

Select Options from the Image Format list.

You see this window:

Image Format : | ERTERTCC I -

Generd Text  Sequmity

[lGenerate FOF A Fle

Page humber ; (8 Create fie with al pages

(O Select rumber to make e

Color (Grayscale ; | Standerd Compression wr

[mage Qualty : I i
High Compresson High Qualty
e ) Cangel

Select any of the options on the General tab.
Select the Text tab.
Make sure the language used in the document text is selected as the Text Language setting.

Select the Security tab if you want to add a password to the PDF or protect printing or editing
properties.

Click OK.
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13. Confirm the File Name setting and select a Folder setting for your document.
14. Click Scan.

The scanned image is saved as a searchable PDF.
Parent topic: Scanning Special Projects

Related topics
Loading Originals

Saving Scanned Documents as a Searchable PDF with Document Capture - Mac

You can scan a document with Document Capture and save the text in a searchable PDF. In a

searchable PDF, text is recognized using Optical Character Recognition (OCR) and then embedded in
the scanned original.

Note: The settings may vary, depending on the software version you are using. See the Help information
in Document Capture for details.
1. Load your original in the product for scanning.

2. Open the Applications folder, open the Epson Software folder, and select Document Capture.
You see a window like this:

D> I e R asujee

e = [ -
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Note: You may need to select your scanner from the scanner list.

Click the El Scan icon.
You see a window like this:

L Scan Settings

Scanner: EPSON
Source:  ADF
Double-Sided
Document Size:  Letter

©

Image Type: Auto
Rotation: MNone

(o] o o)

Resolution: Low ﬂ

[+ 8

o
Text Enhancemeant

Correct Decumaent Skew
Skip Blank Page

Show the confirmation dialog after scanning

? Cancel | (LN

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the Start Job button, and skip the rest of these steps.

Select any displayed scan settings you want to use.
Note: See the Help information in Document Capture for details.

If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.
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10.
11.
12.

Click the |§| Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.

Click Scan.

You see a preview of your scan in the Document Capture window.
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Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

Check the scanned images and edit them as necessary.

Open the File menu at the top of the Mac desktop and select Save As.
Select PDF as the File Type setting and click the Options button.
Select the Create Searchable PDF checkbox and click OK.

95



13. Click one of the Destination icons to choose where to send your scanned file. (If you cannot see all
of the icons below, click the arrow next to the icons.)
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14. Depending on the destination you chose, click OK or Send to complete the operation.
Parent topic: Scanning Special Projects

Related topics
Loading Originals

Saving a Scan as an Office Format File - Windows

You can use Document Capture Pro (Windows) to save your scans in one of the following Microsoft
Office file formats: Microsoft Word (.docx), Microsoft Excel (.xIsx), or Microsoft PowerPoint (.pptx).

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

Load your original in the product.
2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
» Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click B or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

3. Select the Simple Scan tab.
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You see a window like this:
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Document Capture Pro
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If you want to select specific scan settings for the scan, click the Scan Settings button, select any
displayed settings you want to use, and click OK.

Note: See the help information in Document Capture Pro for details.

Do one of the following:

* To scan the front side of an original, select SCAN single sided.

» To scan both sides of an original,select SCAN double sided.

Your product starts scanning and you see the Edit Scanned Results window.

View and edit the scanned pages as necessary and click Next when you are finished.

Note: See the help information in Document Capture Pro for details.

Click one of the destination icons (except Print) to choose where to send your scanned files. You
see the settings window.

Select the Office format file you want to use from the File Type drop-down list.

Note: The first time you select an Office format file you are prompted to download a plug-in update
for Microsoft Office files. Select Yes to download and install the plug-in.
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9. Click Option to display additional settings.
10. Select any additional settings as necessary and click OK.

Note: See the help information in Document Capture Pro for details.

11. Confirm your settings and click Complete.
Your originals are saved in the Office file format you selected.
Parent topic: Scanning Special Projects

Related topics
Loading Originals

Saving a Scan as an Office Format File - Mac

You can use Document Capture (Mac) to save your scans in one of these Microsoft Office file formats:
Microsoft Word (.docx) and Microsoft Excel (.xlIsx).

Note: The settings may vary, depending on the software version you are using. See the Help information
in Document Capture for details.

1. Load your original in the product for scanning.
2. Open the Applications folder, open the Epson Software folder, and select Document Capture.

98



You see a window like this:
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Note: You may need to select your scanner from the scanner list.

Click the E' Scan icon.
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You see a window like this:

a Scan Settings

Scanner: EPSON
Source:  ADF
Double-Sided
Document Size:  Letter

e

Image Type: Auto
Rotation:  Mone
Resolution: Low H
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Text Enhancement

Correct Documaent Skew
Skip Blank Page

Show the confirmation dialog after scanning

? Cancel | L

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the 22| Start Job button, and skip the rest of these steps.

Select any displayed scan settings you want to use.
Note: See the Help information in Document Capture for details.

If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.

Click the [2] Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.

Click Scan.
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You see a preview of your scan in the Document Capture window.
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Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

8. If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.
10. Open the File menu at the top of the Mac desktop and select Save As.
11. Select DOCX (Word) or XLSX (Excel) as the File Type setting.

Note: The first time you select an Office file type setting in Document Capture, you see a prompt to
download a necessary plug-in for Microsoft Office files. Select Yes and follow the on-screen
instructions to download and install the plug-in to continue.

12. Click the Options button, select any necessary Office file type options, and click OK.
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13. Click one of the Destination icons to choose where to send your scanned file. (If you cannot see all
of the icons below, click the arrow next to the icons.)
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14. Depending on the destination you chose, click OK or Send to complete the operation.
Parent topic: Scanning Special Projects

Related topics
Loading Originals

Scanning to a SharePoint Server or Cloud Service - Windows

You can use Document Capture Pro (Windows) to upload scanned images to a SharePoint server or a
cloud service.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

Load your original in the product.
2. Do one of the following to start Document Capture Pro:

* Windows 11: Click , then search for Document Capture Pro and select it.

* Windows 10: Click E and select Epson Software > Document Capture Pro.
» Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

* Windows (other versions): Click B or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

3. Select the Simple Scan tab.
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You see a window like this:
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Document Capture Pro
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If you want to select specific scan settings for the scan, click the Scan Settings button, select any
displayed settings you want to use, and click OK.

Note: See the help information in Document Capture Pro for details.

Do one of the following:

* To scan the front side of an original, select SCAN single sided.

» To scan both sides of an original,select SCAN double sided.

Your product starts scanning and you see the Edit Scanned Results window.

View and edit the scanned pages as necessary and click Complete when you are finished.

Note: See the help information in Document Capture Pro for details.

Click one of the cloud server or service destination icons. You see the settings window.

Enter any required information to set up the destination. You may need to log in to your cloud service
to authenticate the connection and allow Document Capture Pro to access the cloud service.

Adjust any settings and click Complete.

Note: See the help information in Document Capture Pro for details.
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Your originals are uploaded to the indicated server or cloud service.
Parent topic: Scanning Special Projects

Related topics
Loading Originals

Scanning to a SharePoint Server or Cloud Service - Mac
You can use Document Capture to upload scanned images to a SharePoint server or a cloud service.
1. Open the Applications folder, open the Epson Software folder, and select Document Capture.
You see a window like this:
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Note: You may need to select your scanner from the scanner list.

2. Click the [2] scan icon.
3. Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture for details.

4. Click Scan.
You see a preview of your scan in the Document Capture window.
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5. Click one of the cloud service Destination icons to choose where to save your scanned file. (If you
cannot see all of the icons, the service software may not be installed, the service may not be
available on your platform, or you need to click the arrow next to the icons.)

You see the Transfer Settings window.

6. Enter any required information to set up the destination. You may need to log in to your cloud service
to authenticate the connection and allow Document Capture to access the cloud service. If you have
previously created a saved setting for the destination, select it from the drop-down list.

7. Adjust any save settings, then click OK or Send, depending on the destination.
Your originals are scanned and uploaded to the indicated server or cloud service.
Parent topic: Scanning Special Projects

Related topics
Loading Originals
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Using the Optional Flatbed Scanner Dock - Windows

The optional flatbed scanner dock combines your document scanner with a flatbed scanner into a single
unit (DS-530 II/DS-770 I1). This allows you to scan thick or over-sized originals, such as cardboard and
books, that won't fit into the document scanner's ADF.

You must purchase a flatbed scanner (Epson Perfection V19/V39) to use the optional flatbed scanner
dock. To attach the flatbed scanner and dock to your document scanner, follow the installation
instructions that came with your flatbed scanner dock.

See these sections to learn about the flatbed scanner dock option.

Note: Your product may differ from the images in this guide, but the instructions are the same unless
otherwise noted.

Flatbed Scanner Dock Parts

Scanning from the Flatbed Scanner Dock
Cleaning the Flatbed Scanner Dock
Transporting the Flatbed Scanner Dock

Flatbed Scanner Dock Parts
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1 Stopper
2 Output tray extension

3  Scanner cover/output tray

1 USB port 1 (for connecting flatbed dock to computer)
2 USB port 2 (for connecting flatbed dock to document scanner)
3  Powerinlet

Parent topic: Using the Optional Flatbed Scanner Dock - Windows

Scanning from the Flatbed Scanner Dock
See these sections to scan when using the optional flatbed scanner dock.

Scanning from the Docked Flatbed Scanner
Scanning from the ADF with the Flatbed Scanner Dock Attached

Parent topic: Using the Optional Flatbed Scanner Dock - Windows

Scanning from the Docked Flatbed Scanner

You can place originals directly on the scanner glass of the flatbed scanner attached to the optional
flatbed scanner dock.
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Caution: Make sure the scanner is placed on a flat surface. Do not place heavy objects on the scanner
glass and do not press on the glass with too much force, or it may damage the scanner. Do not leave
photos on the scanner glass for an extended period, or they may stick to the glass.

1. Close the document scanner's output tray.
2. Open the flatbed scanner cover.

3. Place your original facedown on the scanner glass with the top edge facing as shown. Slide the
original to the edges of the indicated corner.
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Note: Place your original 0.1 inch (2.5 mm) from the top and side edges of the scanner glass as
shown in order to avoid cropping. If you are scanning multiple photos at once, place them at least
0.8 inch (20 mm) apart from each other.
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4. Close the flatbed scanner cover gently to keep your original in place. If you are scanning a book or
other thick document, hold the scanner cover down as you scan.

Start Document Capture Pro (Windows), Document Capture (Mac), or Epson Scan 2.
Select Scanner Glass as the Document Source setting.

Select other scan settings as necessary.

Click Scan.

Parent topic: Scanning from the Flatbed Scanner Dock

Related tasks
Scanning from the ADF with the Flatbed Scanner Dock Attached
Scanning in Epson Scan 2

Scanning from the ADF with the Flatbed Scanner Dock Attached

Depending on the length of your originals, you may need to adjust the position of the input tray, output
tray, and stopper when scanning from the document scanner's ADF with the optional flatbed scanner
dock attached.

For originals shorter than 8.2 inches (210 mm) long:
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* Open the document scanner's input tray, pull out the output tray and output tray extension, and open
the stopper.

+ Extend the output tray a little longer than the length of the original and move the stopper forward or
backward as necessary.
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For originals between 8.2 inches (210 mm) and 11.7 inches (297 mm) long:

* Open and extend the document scanner's input tray, open the flatbed scanner's stopper, and slide the
stopper forward or backward so that it is a little longer than the length of the original. (Do not open the
output tray on the document scanner.)

For originals between 11.7 inches (297 mm) and 14 inches (356 mm) long:

* Open the document scanner's input tray, pull out and extend the scanner dock's output tray and output
tray extension, and open the stopper. (Do not open the output tray on the document scanner.)

» Extend the output tray a little longer than the length of the original and move the stopper forward or
backward as necessary.

For originals that are 14 inches (356 mm) or longer:
+ Open the document scanner's input tray.
» Leave the output tray closed, and close the flatbed and document scanner's stoppers.
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Parent topic: Scanning from the Flatbed Scanner Dock

Related tasks
Scanning from the Docked Flatbed Scanner
Scanning in Epson Scan 2

Cleaning the Flatbed Scanner Dock

To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it. Do not open the product
case.

1. Turn off the document scanner using the o power button.
Note: There is no power button on the scanner dock.

2. Unplug the AC power cord and disconnect the USB cable that connects the flatbed scanner dock to
the computer.
3. Clean the outer case with a cloth dampened with mild detergent and water.

4. If the scanner glass is dirty, clean it with a soft dry cloth. If the glass surface is stained with grease or
some other hard-to-remove material, use a small amount of glass cleaner on a soft cloth to remove
it. Wipe off all remaining liquid.

Caution: Do not spray glass cleaner directly on the scanner glass. Do not press the surface of the
scanner glass with any force and be careful not to scratch or damage the scanner glass. A damaged
glass surface can decrease the scan quality.

Parent topic: Using the Optional Flatbed Scanner Dock - Windows

Transporting the Flatbed Scanner Dock

If you need to ship your product, transport it a long distance, or store it for an extended period, prepare it
for transportation as described here.

Note: If you are transporting only the flatbed scanner dock (without the document scanner), follow the
installation instructions that came with the flatbed scanner dock in reverse to remove the flatbed scanner
and dock from the document scanner.
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Turn off the document scanner using the O power button.

Note: There is no power button on the flatbed scanner.

Unplug the AC power cord and disconnect the USB cable that connects the flatbed scanner dock to
the computer.
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3. Lift the entire scanner unit as shown, making sure to keep it level during transport.

4. Place the scanner unitin its original packing materials if possible, or use equivalent materials with
cushioning around the scanner.

Caution: Avoid turning the scanner upside down when transporting it or you may damage the
scanner.

Parent topic: Using the Optional Flatbed Scanner Dock - Windows
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Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Cleaning Inside Your Scanner
Replacing the Scanner Rollers
Transporting Your Product

Cleaning Your Product
To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it. Do not open the product's
outer case.

Turn off the scanner and unplug the AC adapter.
Disconnect any connected cables.
3. Clean the outer case with a soft, dry cloth. Do not use liquid or chemical cleansers.

Note: If the outer case still requires additional cleaning, use a slightly damp cloth to wipe the outer
case. Then wipe the case with a soft, dry cloth.

Parent topic: Cleaning and Transporting Your Product

Cleaning Inside Your Scanner

Clean your scanner regularly to make sure that no dust builds up on the glass scanning surfaces. Dust
can cause spots or lines in your scanned images. Clean the inside of the scanner every 5,000 scans.
You can check the latest number of scans using the Epson Scan 2 Utility.

Note: The illustrations show the DS-575W I, but the instructions are the same for the DS-530 Il and DS-
770 1.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.
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1. Turn off the scanner and unplug the AC adapter.
2. Disconnect any connected cables.
3. Pull down on the cover open lever and open the scanner cover.

4. Use a genuine Epson cleaning kit or a soft, moist cloth to wipe off any dust or dirt on the glass
scanning surfaces and the rollers inside the scanner cover. If the glass surface is stained with
grease or some other hard-to-remove material, use a genuine Epson cleaning kit to remove stains.
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Use a small amount of cleaner on the cleaning cloth to remove the stains. Wipe off all remaining
liquid.

Caution: Do not spray glass cleaner directly on the scanning surfaces. Be careful not to place too
much force on the glass.

5. Use a cotton swab to wipe off any dust or dirt on the sensors.

Caution: Do not use liquid or glass cleaner on the cotton swab.
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Wipe off any dust or dirt on the separation roller using a genuine Epson cleaning kit or a soft, moist
cloth.

Caution: Use only a genuine Epson cleaning kit or soft, moist cloth to clean the roller; using a dry
cloth may damage the surface of the roller.
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7. Wipe off any dust or dirt on the pickup roller using a genuine Epson cleaning kit or a soft, moist cloth.

Caution: Use only a genuine Epson cleaning kit or soft, moist cloth to clean the roller; using a dry
cloth may damage the surface of the roller.

8. Pluginthe AC adapter and press the O power button to turn on the scanner.

9. Hold down the < start button for at least two seconds while opening the scanner cover. The rollers
on the bottom move momentarily, and then the scanner enters cleaning mode. Press the < start
button several times to rotate the rollers shown here. Use a genuine Epson cleaning kit or a soft,
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moist cloth to wipe off any dust or dirt on the rollers as they rotate. Repeat this step until the rollers
are clean.

Caution: Be careful not to get your hands or hair caught in the mechanism when operating the roller.

10. Close the scanner cover.
Resetting the Number of Scans After Cleaning
Parent topic: Cleaning and Transporting Your Product

Resetting the Number of Scans After Cleaning
Reset the number of scans using the Epson Scan2 Utility after regular cleaning.
1. Make sure the scanner is turned on and connected to your computer.
2. Do one of the following to open the Epson Scan 2 Utility:

* Windows 11: Click , then search for Epson Scan 2 Utility and select it.
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* Windows 10: Click E and select EPSON > Epson Scan 2 Utility.
+ Windows 8.x: Navigate to the Apps screen and select EPSON > Epson Scan 2 Utility.
* Windows (other versions): Click e or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility.
* Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility.
3. Click the Maintenance tab.
You see a screen like this:

E Epson Scan 2 Utilsty e
Scanner @ | EPSOM o
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B Ragusr Claarang Kert

Hummber of Scans © 0 Flesst

Count Alert Setting : 1000k = fet
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4. Select the Regular Cleaning Alert checkbox and click the Reset button.
5. Close the Epson Scan 2 Utility.
Parent topic: Cleaning Inside Your Scanner
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Replacing the Scanner Rollers

Replace the scanner rollers when the number of scans exceeds the life cycle of the rollers. Check the
scanner roller counter to see when you need to replace the rollers.

Note: The illustrations show the DS-575W I, but the instructions are the same for the DS-530 Il and DS-
770 11.

Note: Frequent use of textured media may cause premature wear on the rollers. If frequent paper jams
occur before the life cycle of the rollers is exceeded, try cleaning the rollers. In some cases, the rollers
may need to be replaced before the number of scans exceeds the life cycle of the rollers.

Turn off the scanner.
Unplug the AC adapter.
Disconnect any connected cables.

o bd =

Pull down on the cover open lever and open the scanner cover.
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latch and pull up the cover to remove it

5. Press down on the pickup roller cover




6. Pull down the tab on the pickup roller and slide the roller to the right to remove it.

Note: Do not use force to pull out the pickup roller; doing so may damage the inside of the scanner.

7. Toinstall the new pickup roller, align the notches on the roller unit and slide it to the left. Press up on
the tab to secure the roller.
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8. Align the bottom edge of the pickup roller cover into the notches as shown and press it down until it
clicks into place.

Note: If you are not able to close the cover, the pickup roller is not installed correctly. Remove the
roller unit and reinstall it, then try to close the cover again.
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9. Squeeze the tabs on the sides of the separation roller cover and open the cover.

Caution: Be careful not to apply too much force when opening the cover.
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11. To install a new separation roller, insert the end of the roller into the hole on the right side and lower
the other end of the roller into place.

12. Close the separation roller cover until you hear it click into place.

Note: If you are not able to close the cover, the roller is not installed correctly. Remove the roller and
reinstall it, then try to close the cover again.

13. Close the scanner cover.

14. Connect any disconnected cables.

15. Plug in the AC adapter and turn on the scanner.
16. Reset the roller counter.

Note: Make sure to dispose of the pickup roller and the separation roller following the rules and
regulations of your local authority. Do not disassemble them.

Resetting the Scanner Roller Counter
Parent topic: Cleaning and Transporting Your Product

Related references
User Replaceable Epson Scanner Parts

Related tasks
Resetting the Number of Scans After Cleaning
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Resetting the Scanner Roller Counter

Resetting the Scanner Roller Counter

When you replace the scanner rollers, reset the scanner roller counter so you know when you may need
to replace the rollers again.

1. Make sure the scanner is turned on and connected to your computer.
2. Do one of the following to open the Epson Scan 2 Ultility:

* Windows 11: Click , then search for Epson Scan 2 Utility and select it.
* Windows 10: Click E and select EPSON > Epson Scan 2 Utility.
* Windows 8.x: Navigate to the Apps screen and select EPSON > Epson Scan 2 Utility.

* Windows (other versions): Click E’ or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility.
* Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility.

3. Click the Counter tab.
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You see a screen like this:

B Epzon Scan 2 Utility E
Seanver : | EPSON |

Informaten  COUNTEr  Dower Save  Mantsnance Adpatments Soanner Sattng  Other

Scan Courber
Scanner Glass @ Mo Information
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Paper lam: O
Double Feed : O
Paper Protecton: 0
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4. Click Reset.

The Number of Scans field changes to 0 (zero).
5. Close the Epson Scan 2 Utility.
Parent topic: Replacing the Scanner Rollers

Transporting Your Product

If you need to ship your product, transport it a long distance, or store it for an extended period, prepare it
for transportation as described here.
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Note: The illustrations show the DS-575W I, but the instructions are the same for the DS-530 Il and DS-
770 11.

1. Turn off the product and unplug the AC adapter.
2. Disconnect any connected cables.
3. Close the input tray and the output tray.

Note: Make sure the output tray is securely closed.

4. Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product.

Parent topic: Cleaning and Transporting Your Product
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Administering Your Product (DS-575W II)

Follow the instructions in these sections to configure your product's administrator settings using the Web
Config software.

Note: Before you can configure system administration settings, you must connect the product to a
network.

Notes on the Administrator Password
Connecting the Product to the Network
Accessing the Web Config Utility
Restricting Features Available for Users
Registering an Email Server

Configuring Product Settings

Importing and Exporting Product Settings
Using Your Product on a Secure Network

Related topics
Wi-Fi Networking

Notes on the Administrator Password

This product allows you to set an administrator password to prevent unauthorized third parties from
accessing or changing the product settings or the network settings stored in the product when it is
connected to a network.

If you set an administrator password, you need to enter the password when changing settings in
configuration software such as Web Config.

The initial administrator password is set on the product, but you can change it to a password of your
choice. The default value of the administrator password is printed on the product's label. The label is
located on the side, the back, or the bottom, depending on the product. If there is no "PASSWORD" label
attached, enter the serial number from the label attached to the back of the product for the default
administrator password. (No user name is set as default.)

Note: Depending on the time and region when the product was purchased, a default administrator
password may have been set or you may be prompted to set an administrator password when you first
access Web Config.
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You must enter the administrator password when performing the following operations:
* Accessing the advanced settings in Web Config

» Updating your product's firmware from a computer or smart device

* Using applications that can change the product's settings

» Selecting a menu on the control panel that has been locked by an administrator

» Changing or resetting the administrator password

You can change the administrator password from the product's control panel or Web Config. The new
password must be 8 to 20 characters long and only contain single-byte alphanumeric characters and
symbols.

You can restore the administrator password to the default setting from the product's control panel or
Web Config. If you have forgotten the password and cannot restore it to the default settings, contact
Epson for help.

Parent topic: Administering Your Product (DS-575W II)

Connecting the Product to the Network

Follow the instructions in these sections to connect the product to the network.

Before Connecting to the Network

IP Address Assignment

DNS Server and Proxy Server

Assigning the IP Address Using Web Config

Parent topic: Administering Your Product (DS-575W II)

Before Connecting to the Network

Before connecting the product to the network, configure the necessary settings for the connection type in
advance.
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Connection type

Settings

Description

LAN connection

IP address

Subnet mask

Default gateway

Determine the IP address to assign to the
product

When assigning a static IP address, you
need to configure the IP address settings
directly on the product or through a network
configuration interface.

When assigning a dynamic |P address using
the DHCP function, connection information
is not required because it is set
automatically.

Wi-Fi connection

SSID

Password

Determine the SSID (network name) and the
password of the access point to which the
product will connect.

If MAC address filtering has been set,
register the MAC address of the scanner in
advance to register the scanner. See
"Network Interface Specifications" for the
supported standards.

DNS server

IP address for primary DNS

IP address for secondary
DNS

Setting the IP address is required when
specifying DNS servers

The secondary DNS is set when the system
has a redundant configuration and there is a
secondary DNS server. If you are in a small
organization and do not set the DNS server,
set the IP address of the router.

Proxy server

Proxy server name

Enter the proxy server name if your network
environment uses a proxy server to access
the internet from the intranet

The product directly connects to the internet
for the following functions:

» Firmware updating

Port number information

Port number to release

Check the port number used by the product
and computer, then release the port that is
blocked by a firewall, if necessary.
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Parent topic: Connecting the Product to the Network

IP Address Assignment
You can select the type of IP address to assign to the product.

Static IP address
A static IP address is fixed and does not change when the device connects to the network. The
settings required to connect to the network (subnet mask, default gateway, DNS server, etc.) need to
be configured manually. Use a static IP address when you want to manage the device on a network
that many computers access. Also, when using security features such as IPsec/IP filtering, assign a
static IP address to ensure that the IP address does not change.

Dynamic IP address
A dynamic IP address is automatically assigned to your product by a DHCP (Dynamic Host
Configuration Protocol) server whenever it connects to a network. The settings required to connect to
the network (subnet mask, default gateway, DNS server, etc.) are set automatically, so you can easily
connect the device to the network. If the device or the router is turned off, or depending on the DHCP
server settings, the IP address may change when re-connecting.

Note: If you use the IP address reservation function of the DHCP, you can assign the same IP
address to the devices at any time.

Parent topic: Connecting the Product to the Network

DNS Server and Proxy Server

DNS Server
A DNS server translates domain names (such as www.example.com) into IP addresses which are
used by computers to identify each other on the network.

When you type a domain name into a web browser, your computer sends a request to a DNS server
to find the corresponding IP address. This process is called name resolution. If the DNS server
doesn't have the information cached, it will query other DNS servers until it finds the correct IP
address or determines that the domain doesn't exist. Name resolution is necessary for the scanner to
communicate using the email function or Internet connection function. If you use those functions,
configure the DNS server settings. When you assign the scanner's IP address using the DHCP
function of the DHCP server or router, it is automatically set.

Proxy Server
A proxy server filters content based on predefined rules, blocks malicious websites, and enforces
security policies. It can also provide firewall capabilities to protect internal networks from external
threats.

133



The proxy server is placed at the gateway between a client (such as a user's computer) and another
server (such as a web server) to process and forward requests. When you connect to a website
through a proxy server, your request first goes to the proxy server, which then forwards it to the
destination server. The response from the destination server then returns to the proxy server, which
sends it back to you. The destination server communicates only with the proxy server. Therefore,
scanner information (such as the IP address and port number) is hidden and increased security is
expected. When you connect to the Internet via a proxy server, configure the proxy server on the
scanner.

Parent topic: Connecting the Product to the Network

Assigning the IP Address Using Web Config

You can set up a static IP address for your product using Web Config. Make sure the computer and your
product are connected to the same wireless network.

Note: You can also use the product's software installer to set up a static IP address. Follow the
instructions on the Start Here sheet and install the necessary software by downloading it from the Epson
website. On the Select Your Connection Method screen, select the option to connect your product to Wi-
Fi using a different method, and then select Advanced configuration. Enter the static IP address, and
then follow the on-screen instructions.
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Turn on the product, if necessary.

Log in to the Web Config interface as an administrator.
Select the Network tab.

Select Manual as the Obtain IP Address setting.

Set up the IP Address, Subnet Mask and Default Gateway.

Note: Make sure you enter the information correctly. If the combination of the IP Address, Subnet
Mask and Default Gateway is incorrect, you cannot proceed with the settings.

Set any other settings, as needed.

Note: Select Auto as the DNS Domain Name Setting option if you are not manually entering a DNS
Domain Name.

Select Next to see a summary of the network settings.
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8. Select OK to accept the changes.

Note: The network connection will be temporarily interrupted to enable the new settings.

Parent topic: Connecting the Product to the Network

Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

Note: You can also access the Web Config utility from the product information area in the Epson Smart

Panel app.

1. Determine your product's IP address.

2. Launch an internet browser on a computer that is using the same network as your product.

3. Type your product's IP address into the address bar and press Enter.

4. If you see a warning about the self-signed certificate, ignore the warning and continue to the product

IP address. See your browser help for details.

Note: Depending on the time and region when the product was purchased, a default administrator
password may have been set or you may be prompted to set an administrator password when you
first access Web Config.

In the upper right corner of the screen, click Log in and enter the Administrator password using the
following default values:

* User name: none (blank)

+ Password: If there is a "Password" label attached to the back of your product, enter the 8-digit
number shown on the label. If there is no "Password" label, enter the serial number shown on the
label attached to your product.

Click OK.
You see the available Web Config utility options.

Parent topic: Administering Your Product (DS-575W II)
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Restricting Features Available for Users

Follow the instructions in these sections to restrict users from using certain product features and create
an administrator password to lock the restrictions using the Web Config software.

Changing the Administrator Password in Web Config
Locking the Buttons on the Control Panel using Web Config
Disabling Network Scanning

Disabling WSD Scan

Parent topic: Administering Your Product (DS-575W II)

Changing the Administrator Password in Web Config

You can set an administrator password using your product's control panel, Web Config, or EpsonNet
Config. You use the same administrator password in all cases.

Note: If you forget your administrator password, contact Epson for support.
1. Access Web Config and select the Product Security tab.

Note: Depending on the time and region when the product was purchased, you may be prompted to
set an administrator password when you first access Web Config.

2. Select Change Administrator Password.
3. Enter a user name, if necessary.
4. Do one of the following:

+ If you have set an administrator password before, enter the current password, then enter and
confirm the new password in the fields provided.

+ If you have not set an administrator password before, enter the default password, then enter a
new password and confirm it in the fields provided.

Note: Be sure to remember the administrator password you set. If you forget your password, you
will not be able to reset it and you will need to contact Epson.

5. Click OK.
Parent topic: Restricting Features Available for Users
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Related tasks
Accessing the Web Config Utility

Locking the Buttons on the Control Panel using Web Config

You can lock the @& Wi-Fi connect and & Wi-Fi buttons so that network settings cannot be changed
from the control panel.

1.
2.
3.

4.

Access Web Config and select the Device Management tab.
Select Control Panel.
Select ON for the Panel Lock setting.

Note: If Panel Lock is not displayed in Web Config, it is automatically enabled when you set an
administrator password for the scanner.

Click OK to save your setting.

Parent topic: Restricting Features Available for Users

Related tasks
Accessing the Web Config Utility

Disabling Network Scanning

You can make the following settings in Web Config to disable network scanning using Epson Scan 2
from your computer.

1.

L S

Access Web Config and select the Scan tab.

Select Network Scan.

Under EPSON Scan, deselect the Enable scanning check box.
Click Next.

Click OK to confirm your setting.

Parent topic: Restricting Features Available for Users

Disabling WSD Scan

If you do not want your computer to configure the scanner as a WSD scanning device, follow the steps
below to disable the WSD settings.

1.

Access Web Config and select the Network Security tab.
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Select Protocol.

Under WSD Settings, deselect the Enable WSD check box.
Click Next.

Click OK to confirm your setting.

Parent topic: Restricting Features Available for Users

Registering an Email Server

If you want to send a scanned file by email, you need to register the email server first. You can select
settings for the email server using Web Config.

Note: Before registering the email server, make sure the product is connected to the network. If you are
using an Internet-based email server, check the setting information from the provider or website.
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5.

Access Web Config.
Select the Network tab.
Select Email Server > Basic.

Select an authentication method, then select the settings you want to use. Contact your internet
service provider if necessary to confirm the authentication method for the email server.

Select OK.

Email Server Settings

Enabling SMTP AUTH in Exchange Online

Setting Up OAuth 2.0 Authentication

Checking an Email Server Connection

Mail Server Connection Test Messages

Parent topic: Administering Your Product (DS-575W II)

Related tasks
Accessing the Web Config Utility

Email Server Settings
You can configure these email server settings in Web Config.
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Setting

Options/Description

Authentication Method

Select the authentication method that matches your email
server

Note: If you are using Microsoft Exchange Online, the
previous Basic Authentication method has been discontinued
and SMTP authentication (SMTP AUTH) has been disabled by
default. You will need to use the OAuth2 authentication
method. If you use the email sending and email notification
functions of the product, configure the email server settings to
use OAuth2 authentication. You should also enable SMTP
AUTH in Exchange Online.

Email service

If you select OAuth2 as the Authentication Method, select
an email service from the drop-down list. Click Sign In and
then follow the on-screen instructions to sign in to the email
service.

Note: For personal use, select Outlook.com.

Authenticated Account

Enter the authenticated account name from 1 to 255
characters long in ASCII

Authenticated Password

Enter the authenticated password from 1 to 20 characters long
in ASCII using A-Z, a-z, 0-9, and these characters:

1#$ %' *+-. /=24 _{1}~@

Note: You may be required to use an App password rather
than your email login password. Check with your email service
provider.

Sender's Email Address

Enter the sender's email address from 1 to 255 characters
long in ASCII; do not use a period (.) as the first character or
use these characters: ()<>[];

SMTP Server Address Enter the SMTP server address from 1 to 255 characters long
using A-Z, a-z, 0-9, and "-" in IPv4 or FQDN format
SMTP Server Port Number Enter the SMTP server port number between 1 and 65535

Secure Connection

Select the security method for the email server; available
choices depend on the Authentication Method setting
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Setting Options/Description

Certificate Validation (Web Config Enable checking for a valid certificate; recommended value is

only) Enable

POP3 Server Address Enter the POP server address from 1 to 255 characters long
using A-Z, a-z, 0-9, and "-" in IPv4 or FQDN format

POP3 Server Port Number Enter the POP server port number between 1 and 65535

Parent topic: Registering an Email Server

Related tasks
Enabling SMTP AUTH in Exchange Online
Setting Up OAuth 2.0 Authentication

Enabling SMTP AUTH in Exchange Online

Enable SMTP AUTH in Exchange Online if you want to use the product's email sending and notification
functions.

Note: For detailed instructions, see the Microsoft Learn site.

1. In the Exchange admin center, disable security defaults for the entire organization and then enable
SMTP AUTH.
2. Inthe Microsoft 365 admin center, enable SMTP AUTH for the product administrator's mailbox.

Parent topic: Registering an Email Server

Setting Up OAuth 2.0 Authentication

You can set up OAuth 2.0 authentication for your email server using Web Config.
1. Log in to the Web Config interface as an administrator.

2. Select the Network tab, then select Email Server > Basic.

3. Select OAuth2 as the Authentication Method.

4. Select Microsoft Exchange Online as the Email service.

Note: For personal use, select Outlook.com.

5. Click Sign In, then click Sign in with Microsoft on the window that appears.
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10.

11.

When you are signed in, an authentication code is displayed.

Copy the authentication code, then click on the URL below it.

On the authentication code window, enter the code you copied, and then click Next.
On the Microsoft sign-in window, enter your account details and then click Next.

Note: To sign in, your account must have the Cloud Application Administrator role assigned.
Enter your password and click Sign In.
Note: Additional steps may be required. Follow the on-screen instructions.

A confirmation screen appears.
Select Consent on behalf of organization and then click Accept.

When authentication is complete, a sign-in message is displayed and you can close the browser
screen. You can check the sign-in status in Web Config (Network tab > Email Server > Basic).
When the status shows as Signed in, account information for OAuth 2.0 authentication is displayed.

Click OK to send OAuth 2.0 authentication information to the product.

Parent topic: Registering an Email Server

Checking an Email Server Connection
You can check an email server connection using the product's control panel or Web Config.

1.

Choose one of the following to open the connection test menu:
+ Using Web Config: Select the Network tab > Email Server > Connection Test > Start.

Note: You may need to log in as an administrator.

The mail server connection test is started.

Check the test results.
If the connection test is successful, a confirmation message displays. If an error message displays,
follow the instructions to clear the error.

Parent topic: Registering an Email Server
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Mail Server Connection Test Messages

The table below lists some common causes for mail server connection test messages.

Note: You may be required to use an App password rather than your email login password. Check with

your email service provider.

Message

Cause

SMTP server communication error.
Check the following. - Network
Settings

The scanner is not connected to a network
The SMTP server is down

The network connection is disconnected while communicating
with the SMTP server

Data received is incomplete

POP3 server communication error.
Check the following. - Network
Settings

The scanner is not connected to a network
The POP3 server is down

The network connection is disconnected while communicating
with the POP3 server

Data received is incomplete

An error occurred while connecting
to SMTP server. Check the
followings. - SMTP Server Address
- DNS Server

Connecting to a DNS server failed
Name resolution for an SMTP server failed

An error occurred while connecting
to POP3 server. Check the
followings. - POP3 Server Address
- DNS Server

Connecting to a DNS server failed
Name resolution for a POP3 server failed

SMTP server authentication error.
Check the followings. -
Authentication Method -
Authenticated Account -
Authenticated Password

SMTP server authentication failed
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Message

Cause

POP3 server authentication error.
Check the followings. -
Authentication Method -
Authenticated Account -
Authenticated Password

POP3 server authentication failed

Unsupported communication
method. Check the followings. -
SMTP Server Address - SMTP
Server Port Number

Communication method contained unsupported protocols

Connection to SMTP server failed.

Change Secure Connection to
None.

An SMTP mismatch occurred between a server and a client, or the
server does not support SMTP secure connection (SSL
connection).

Connection to SMTP server failed.

Change Secure Connection to
SSL/TLS.

An SMTP mismatch occurred between a server and a client, or the
server requested to use an SSL/TLS connection for an SMTP
secure connection

Connection to SMTP server failed.

Change Secure Connection to
STARTTLS.

An SMTP mismatch occurred between a server and a client, or the
server requested to use a STARTTLS connection for an SMTP
secure connection

The connection is untrusted.
Check the following. - Date and
Time

The product’s date and time settings are incorrect, or the
certificate has expired

The connection is untrusted.
Check the following. - CA
Certificate

The scanner does not have a root certificate corresponding to the
server or a CA Certificate has not been imported

The connection is not secured.

The obtained certificate is damaged

SMTP server authentication failed.

Change Authentication Method to
SMTP-AUTH.

An authentication method mismatch occurred between a server
and a client; the server supports SMTP AUTH.

SMTP server authentication failed.

Change Authentication Method to
POP before SMTP.

An authentication method mismatch occurred between a server
and a client; the server does not support SMTP AUTH

Sender's Email Address is
incorrect. Change to the email
address for your email service.

The specified sender’s email address is incorrect

143




Message Cause

Cannot access the product until The scanner is busy
processing is complete.

Parent topic: Registering an Email Server

Configuring Product Settings

Follow the instructions in these sections to configure your product's control panel settings using the Web
Config software.

Checking Status Information
Configuring Email Notification
Managing the Network Connection
Updating Firmware Using Web Config

Parent topic: Administering Your Product (DS-575W II)

Checking Status Information
You can check information about the scanner using Web Config.

Note: Depending on the features of your product, not all of the options below may be available. Some
options are not available unless you are logged in to Web Config.

1. Access Web Config and log in using the administrator name and password.
2. Select the Status tab and choose one of the following options:
+ Select Product Status to view product information.

» Select Network Status to view network information such as the IP address and network
connection status.

+ Select Usage Status to view information about the number of scans and historical information
about the product.

+ Select Hardware Status to view information about the product functions.
Parent topic: Configuring Product Settings

Related tasks
Accessing the Web Config Utility
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Configuring Email Notification

You can configure email notifications using Web Config so you can receive alerts by email when certain

events occur on the product. You can register up to 5 email addresses and select the events for which
you want to be notified.

1. Access Web Config and select the Device Management tab.
2. Select Email Notification.
You see a window like this:

EFSON

CICIERES

.....

3. Select the subject contents from the two drop-down menus.
Enter email addresses in the Address fields as necessary, and select a language for each.

5. Select the checkboxes to indicate the events for which you want each address to receive email
notifications.

6. Click OK.

Parent topic: Configuring Product Settings

Related tasks
Accessing the Web Config Ultility

Managing the Network Connection

You can check or update the network information for your product using the Web Config interface.
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Access Web Config and select the Network tab.
Select Basic.

Check or update the settings as necessary.

Select Next to see a summary of the network settings.
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Select OK to accept the changes.
Note: The network connection will be temporarily interrupted to enable the new settings.
Parent topic: Configuring Product Settings

Updating Firmware Using Web Config

If your product is connected to the Internet, you can update the product firmware using Web Config.

Note: Make sure the product is not in use before starting the update.
You can also update the firmware using Epson Device Admin. See the Epson Device Admin help for

more details.

1. Access Web Config and select the Device Management tab.
2. Select Firmware Update.

3. Click Start to check for the latest firmware.

4. |Ifthere is a firmware update, click Start to begin the update.

Note: Do not turn off the computer or the scanner while updating.

Parent topic: Configuring Product Settings

Related tasks
Accessing the Web Config Utility

Importing and Exporting Product Settings

Follow the instructions in these sections to import and export your product's settings using the Web
Config software.

Exporting Settings Using Web Config
Importing Settings Using Web Config
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Parent topic: Administering Your Product (DS-575W II)

Exporting Settings Using Web Config

You can export your product's settings and optionally encrypt the settings file with a password.

1.
2.
3.

5.

Access Web Config and select the Device Management tab.
Under Export and Import Setting Value, select Export.
Select the settings you want to export.

Note: If you select a parent category, the child categories are also selected. By default, items that
are unique on the network, such as IP address, cannot be selected. If you want to export these
items, select Enable to select the individual settings of device. It is recommended that you
export only unique items when replacing a product on the network, otherwise you may encounter
conflicts on the network.

Enter and confirm an encryption password, if desired.

Note: You will need the password to import the file. Leave this blank if you do not want to encrypt the
file.

Click Export and save the file.

Parent topic: Importing and Exporting Product Settings
Related tasks

Accessing the Web Config Utility

Changing the Administrator Password in Web Config

Importing Settings Using Web Config

You can import the product settings file that was previously exported. If encryption was used when the
settings were exported, obtain the necessary password before you import.

Note: When importing values that include individual information such as a scanner name or IP address,
make sure the same IP address does not exist on the same network.

1.
2.
3.

Access Web Config and select the Device Management tab.
Under Export and Import Setting Value, select Import.
Click Browse or Choose File and select the exported settings file.
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If necessary, enter the decryption password.
Click Next.

Select the settings to import and click Next.
Click OK.

The selected settings are imported to the product.

N o o s

Parent topic: Importing and Exporting Product Settings

Related tasks
Accessing the Web Config Utility

Using Your Product on a Secure Network

Follow the instructions in these sections to configure security features for your product on the network
using the Web Config software.

Configuring Protocols and Services in Web Config
Protocol Settings

Using a Digital Certificate

Configuring SSL/TLS Communication

Configuring IPsec/IP Filtering

Connecting the Product to an IEEE 802.1X Network
Using Epson Device Admin Configuration Software

Parent topic: Administering Your Product (DS-575W II)

Configuring Protocols and Services in Web Config
You can enable or disable protocols using Web Config.
Access Web Config and select the Network Security tab.
Select Protocol.
Select or deselect the checkbox next to the service name to enable or disable a protocol.
Configure any other available protocol settings.
Click Next.
Click OK.
After the protocols restart, the changes are applied.

R i

148



Parent topic: Using Your Product on a Secure Network

Related tasks
Accessing the Web Config Utility

Protocol Settings

Protocols

Name Description

Bonjour Bonjour is used to search for devices and AirPrint

SLP SLP is used for push-scanning and network searching in
EpsonNet Config

WSD Add WSD devices, or print and scan from the WSD port

LLTD Displays the product on the Windows network map

LLMNR Use name resolution without NetBIOS even if you cannot use
DNS

SNMPv1/v2c Remotely set up and monitor your product

SNMPv3 Remotely set up and monitor your product with the SNMPv3
protocol

Bonjour Settings

Setting

Options/Description

Use Bonjour

Search for or use devices through Bonjour

Bonjour Name

Displays the Bonjour name

Bonjour Service Name

Displays the Bonjour service name

Location

Displays the Bonjour location name

Wide-Area Bonjour

Enables the Wide-Area Bonjour protocol; register all products
on the DNS server to locate them over the segment
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SLP Settings

Setting

Options/Description

Enable SLP

Enable the SLP function to use the Push Scan function and
network searching in EpsonNet Config

WSD Settings

Setting

Options/Description

Enable WSD

Enable adding devices using WSD, and printing and scanning
from the WSD port

Scanning Timeout (sec)

Enter the communication timeout value for WSD scanning
between 3 and 3,600 seconds

Device Name

Displays the WSD device name

Location

Displays the WSD location name

LLTD Settings

Setting

Options/Description

Enable LLTD

Enable LLTD to display the product in the Windows network
map

Device Name

Displays the LLTD device name

LLMNR Settings

Setting Options/Description

Enable LLMNR Enable LLMNR to use name resolution without NetBIOS, even
if you cannot use DNS

SNMPv1/v2c Settings

Setting Options/Description

Enable SNMPv1/v2c Enable SNMPv1/v2c for products that support SNMPv3
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Setting

Options/Description

Access Authority

Set the access authority when SNMPv1/v2c is enabled to
Read Only or Read/Write

Community Name (Read Only)

Enter 0 to 32 ASCII characters

Community Name (Read/Write)

Enter 0 to 32 ASCII characters

SNMPv3 Settings

Setting Options/Description
Enable SNMPv3 Enable SNMPv3 for products that support SNMPv3
User Name Enter 1 to 32 characters

Authentication Settings

Select an algorithm and set a password for authentication

Encryption Settings

Select an algorithm and set a password for encryption

Context Name

Enter 1 to 32 characters in Unicode (UTF-8)

Parent topic: Using Your Product on a Secure Network

Using a Digital Certificate

Follow the instructions in these sections to configure and use digital certificates using Web Config.

About Digital Certification

Obtaining and Importing a CA-signed Certificate

CSR Setup Settings

CSR Import Settings

Deleting a CA-signed Certificate
Updating a Self-signed Certificate
Importing a CA Certificate
Deleting a CA Certificate

Parent topic: Using Your Product on a Secure Network

About Digital Certification

You can configure the following digital certificates for your network using Web Config:
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CA-signed Certificate
You can ensure secure communications using a CA-signed certificate for each security feature. The
certificates must be signed by and obtained from a CA (Certificate Authority).

CA Certificate
A CA certificate indicates that a third party has verified the identity of a server. You need to obtain a
CA certificate for server authentication from a CA that issues it.

Self-signed Certificate
A self-signed certificate is issued and signed by the product itself. You can use the certificate for only
SSL/TLS communication, however security is unreliable and you may see a security alert in the
browser during use.

Parent topic: Using a Digital Certificate
Obtaining and Importing a CA-signed Certificate

You can obtain a CA-signed certificate by creating a CSR (Certificate Signing Request) using Web
Config and submitting it to a certificate authority. The CSR created in Web Config is in PEM/DER format.
You can import one CSR created from Web Config at a time.

1. Access Web Config and select the Network Security tab.
2. Select one of the following network security options and corresponding certificates:
+ SSL/TLS and select Certificate
 IPsecl/IP Filtering and select Client Certificate
+ IEEE802.1X and select Client Certificate
3. Inthe CSR section, select Generate.
4. Select the CSR setting options you want to use.
5. Click OK.
You see a completion message.

6. Select the Network Security tab and select your network security option and corresponding
certificate again.

7. Inthe CSR section, click the Download option that matches the format specified by your certificate
authority to download the CSR.

Caution: Do not generate another CSR or you may not be able to import a CA-signed certificate.

8. Submit the CSR to the certificate authority following the format guidelines provided by that authority.
9. Save the issued CA-signed certificate to a computer connected to the product.
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Before proceeding, make sure the time and date settings are correct on your product.
10. In the CA Certificate section, click Import.
11. Select the format of the certificate as the Server Certificate setting.

12. Select the certificate import settings as necessary for the format and the source from which you
obtained it.

13. Click OK.

You see a confirmation message.
14. Click Confirm to verify the certificate information.
Parent topic: Using a Digital Certificate

Related references
CSR Setup Settings
CSR Import Settings

Related tasks
Accessing the Web Config Utility

CSR Setup Settings
You can select these settings when setting up a CSR in Web Config.

Note: The available key length and abbreviations vary by certificate authority, so follow the rules of that
authority when entering information in the CSR.

Setting Options/Description
Key Length Select a key length for the CSR
Common Name Enter a name or static IP address from 1 to 128

characters long.

The first element is stored to the common name,
and other elements are stored to the alias field of
the certificate subject. For example:

Scanner's IP address: 192.0.2.123, Scanner
name: EPSONA1B2C3

Common Name:
EPSONA1B2C3,EPSONA1B2C3.local,192.0.2.12
3
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Setting Options/Description

Organization, Organizational Unit, Locality, Enter information in each field as necessary, from

State/Province 0 to 64 characters long in ASCII; separate any
multiple names with commas

Country Enter a two-digit country code number as specified
by the ISO-3166 standard

Sender's Email Address Enter the sender's email address for the mail

server setting

Parent topic: Using a Digital Certificate
CSR Import Settings
You can configure these settings when importing a CSR in Web Config.

Note: The import setting requirements vary by certificate format and how you obtained the certificate.

Certificate format Setting descriptions

PEM/DER format obtained from Web Config Private Key: Do not configure because the
product contains a private key

Password: Do not configure
CA Certificate 1/CA Certificate 2: Optional

PEM/DER format obtained from a computer Private Key: Configure a private key
Password: Do not configure
CA Certificate 1/CA Certificate 2: Optional

PKCS#12 format obtained from a computer Private Key: Do not configure
Password: Optional

CA Certificate 1/CA Certificate 2: Do not
configure

CA-signed Certificate Import Settings
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Setting

Description

Server Certificate or Client Certificate

Select the certificate format.

For an SSL/TLS connection, the Server Certificate
is displayed.

For an IPsec/IP Filtering, IEEE802.1x, or SIMIME
connection, the Client Certificate is displayed.

Note: Depending on your product, not all
connection types may be available.

Private Key If you obtain a certificate of the PEM/DER format
by using a CSR created from a computer, specify a
private key file that matches the certificate.

Password If the file format is Certificate with Private Key

(PKCS#12), enter the password for encrypting the
private key that is set when you obtain the
certificate.

CA Certificate 1

If your certificate’s format is Certificate
(PEM/DER), import a certificate from a certificate
authority that issues a CA-signed Certificate to be
used as the server certificate. Specify a file if
necessary.

CA Certificate 2

If your certificate’s format is Certificate
(PEM/DER), import a certificate from the same
certificate authority that issued CA Certificate 1.
Specify a file if necessary.

Parent topic: Using a Digital Certificate
Deleting a CA-signed Certificate

You can delete an imported CA-signed certificate with Web Config when the certificate expires or if you

have no more need for an encrypted connection.

Note: If you obtained a CA-signed certificate from Web Config, you cannot import a deleted certificate;
you must obtain and import a new certificate.

1. Access Web Config and select the Network Security tab.
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4.

Select one of the following network security options and corresponding certificate:
+ SSL/TLS and select Certificate

* IPsec/IP Filtering and select Client Certificate

+ IEEE802.1X and select Client Certificate

Click Delete.

You see a completion message.

Click OK.

Parent topic: Using a Digital Certificate

Related tasks
Accessing the Web Config Utility

Updating a Self-signed Certificate

If your product supports the HTTPS server feature, you can update a self-signed certificate using Web
Config.

1.
2.
3.

6.
7.

Access Web Config and select Network Security, select SSL/TLS, and select Certificate.
Click Update.
Enter an identifier for your product from 1 to 128 characters long in the Common Name field.

Note: You can add up to 5 IPv4 addresses, IPv6 addresses, host names, or FQDNSs; separated by
commas. The first value is assigned to the Common Name field, and the rest are added to the Alias
field of the certificate subject. You cannot enter a space before or after a comma.

Select a validity period for the certificate as the Certificate Validity (year) setting.
Click Next.

You see a completion message.

Click OK.

Click Confirm to verify the certificate information.

Parent topic: Using a Digital Certificate

Related tasks
Accessing the Web Config Utility
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Importing a CA Certificate
You can import a CA certificate using Web Config.
Access Web Config and select Network Security.
Select CA Certificate.
Select Import.
Select the CA certificate you want to import.
. Click OK.
When you see the CA Certificate page and the imported certificate is displayed, the import is finished.
Parent topic: Using a Digital Certificate

Related tasks
Accessing the Web Config Utility

Deleting a CA Certificate

You can delete an imported CA certificate with Web Config when the certificate expires or if you have no
more need for an encrypted connection.
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1. Access Web Config and select Network Security.

Select CA Certificate.

Locate the certificate you want to remove and click the Delete button next to it.
Click OK to confirm the deletion.

Click Reboot Network, and then check that the deleted CA Certificate is not listed on the updated
screen.

L S

Parent topic: Using a Digital Certificate

Related tasks
Accessing the Web Config Utility

Configuring SSL/TLS Communication

Follow the instructions in these sections to configure SSL/TLS communication using Web Config.

Configuring SSL/TLS Settings
Configuring a Server Certificate for the Product

Parent topic: Using Your Product on a Secure Network
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Configuring SSL/TLS Settings

If your product supports HTTPS, you can configure SSL/TLS to encrypt communications with your
product.

1.

L S

6.

Access Web Config and select the Network Security tab.

Select SSL/TLS > Basic.

Select one of the options for the Encryption Strength setting.

Select Enable or Disable for the Redirect HTTP to HTTPS setting as necessary.
Click Next.

You see a confirmation message.

Click OK.

Parent topic: Configuring SSL/TLS Communication

Related tasks
Accessing the Web Config Utility

Configuring a Server Certificate for the Product

You can configure a server certificate for your product.

1.
2.
3.

5.

Access Web Config and select the Network Security tab.
Under SSL/TLS, select Certificate.
Select one of the following options:

+ CA-signed Certificate: Select Import if you have obtained a CA-signed certificate. Choose the
file to import and click OK.

+ Self-signed Certificate: Select Update if you have not obtained a CA (Certificate Authority)-
signed certificate and want the product to generate a self-signed certificate.

Click Next.
You see a confirmation message.
Click OK.

Parent topic: Configuring SSL/TLS Communication

Related tasks
Accessing the Web Config Ultility
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Configuring IPsec/IP Filtering

Follow the instructions in these sections to configure IPsec/IP traffic filtering using Web Config.

About IPsec/IP Filtering

Configuring the Default IPsec/IP Filtering Policy
Configuring the Group IPsec/IP Filtering Policies
IPsec/IP Filtering Policy Settings

IPsec/IP Filtering Configuration Examples
Configuring an IPsec/IP Filtering Certificate

Parent topic: Using Your Product on a Secure Network
About IPsec/IP Filtering

You can filter traffic to the product over the network based on IP address, service, and port by
configuring a default policy that applies to every user or group connecting to the product. For control of
individual users or user groups, you can configure group policies.

Note: IPsec is supported only by computers running Windows Vista or later, or Windows Server 2008 or
later.

Parent topic: Configuring IPsec/IP Filtering
Configuring the Default IPsec/IP Filtering Policy
You can configure the default policy for IPsec/IP traffic filtering using Web Config.
1. Access Web Config and select the Network Security tab.
Under IPsec/IP Filtering, select Basic.
Select Enable to enable IPsec/IP filtering.
Select the filtering options you want to use for the default policy.
Click Next.
You see a confirmation message.
6. Click OK.
Parent topic: Configuring IPsec/IP Filtering

Related tasks
Accessing the Web Config Utility
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Configuring the Group IPsec/IP Filtering Policies

You can configure group policies for IPsec/IP traffic filtering using Web Config.

o g bk wbd -~

Click Next.
You see a confirmation message.
Click OK.

N

Under IPsec/IP Filtering, select Basic.

Access Web Config and select the Network Security tab.

Click a tab number for the policy number you want to configure.
Select the Enable this Group Policy checkbox.
Select the filtering options you want to use for this group policy.

8. If you want to configure additional group policies, click the next tab number and repeat the

configuration steps as necessary.

Parent topic: Configuring IPsec/IP Filtering

Related tasks
Accessing the Web Config Utility

IPsec/IP Filtering Policy Settings
Default Policy Settings

Setting

Options/Description

Access Control

Permit Access to permit IP packets to pass through

Refuse Access to prevent IP packets from passing
through

IPsec to permit IPsec packets to pass through

IKE Version

Select the version of the Internet Key Exchange (IKE)
protocol (IKEv1 or IKEv2) that matches your network
environment

Authentication Method

Select an authentication method, or select Certificate if
you have imported a CA-signed certificate

Pre-Shared Key

If necessary, enter a pre-shared key between 1 and 127
characters long
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Setting

Options/Description

Confirm Pre-Shared Key

Confirm the pre-shared key you entered

ID Type If you selected IKEv2 as the IKE Version setting, select
the ID type from the list.
ID If you selected IKEv2 as the IKE Version setting, enter

the necessary ID information

Encapsulation

If you selected IPsec as the Access Control option,
select one of these encapsulation modes:

Transport Mode: if you are using the product on the
same LAN; IP packets of layer 4 or later are encrypted

Tunnel Mode: if you are using the product on an Internet-
capable network, such as IPsec-VPN; the header and
data of IP packets are encrypted

Remote Gateway(Tunnel Mode)

If you selected Tunnel Mode as the Encapsulation
option, enter a gateway address between 1 and 39
characters long

Security Protocol

If you selected IPsec as the Access Control option,
select one of these security protocols:

ESP: to ensure the integrity of authentication and data,
and encrypt data

AH: to ensure the integrity of authentication and data; if
data encryption is prohibited, you can use IPsec

Algorithm Settings

Select the encryption algorithm settings for the security
protocol you selected

Group Policy Settings

Setting

Options/Description

Access Control

Permit Access to permit IP packets to pass through

Refuse Access to prevent IP packets from passing
through

IPsec to permit IPsec packets to pass through
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Setting

Options/Description

Local Address(Scanner)

Select an IPv4 or IPv6 address that matches your network
environment; if the IP address is assigned automatically,
select Use auto-obtained IPv4 address

Remote Address(Host)

Enter the device's IP address (between 0 and 43
characters long) to control access, or leave blank to
control all addresses; if the IP address is assigned
automatically, such as by DHCP, the connection may be
unavailable, so configure a static address instead

Method of Choosing Port

Select the method you want to used for specifying ports

Service Name

If you selected Service Name as the Method of
Choosing Port option, select a service name option here;
see the next table for more information

Transport Protocol

If you selected Port Number as the Method of Choosing
Port option, select one of these encapsulation modes:

Any Protocol
TCP

UDP

ICMPv4

See the Group Policy Guidelines table for more
information.

Local Port

If you selected Port Number as the Method of Choosing
Port option, and TCP or UDP for the Transport Protocol
option, enter the port numbers that control receiving
packets (up to 10 ports), separated by commas, for
example 25,80,143,5220; leave this setting blank to
control all ports; see the next table for more information

Remote Port

If you selected Port Number as the Method of Choosing
Port option, and TCP or UDP for the Transport Protocol
option, enter the port numbers that control sending
packets (up to 10 ports), separated by commas, for
example 25,80,143,5220; leave this setting blank to
control all ports; see the next table for more information

162




Setting

Options/Description

IKE Version

Select IKEv1 or IKEv2 depending on the device that the
product is connected to

Authentication Method

If you selected IPsec as the Access Control option,
select an authentication method here

Pre-Shared Key

If you selected Pre-Shared Key as the Authentication
Method option, enter a pre-shared key between 1 and
127 characters long here and in the Confirm Pre-Shared
Key field

ID Type If you selected IKEv2 as the IKE Version setting, select
the ID type from the list
ID If you selected IKEv2 as the IKE Version setting, enter

the necessary ID information

Encapsulation

If you selected IPsec as the Access Control option,
select one of these encapsulation modes:

Transport Mode: if you are using the product on the
same LAN; IP packets of layer 4 or later are encrypted

Tunnel Mode: if you are using the product on an Internet-
capable network, such as IPsec-VPN; the header and
data of IP packets are encrypted

Remote Gateway(Tunnel Mode)

If you selected Tunnel Mode as the Encapsulation
option, enter a gateway address between 1 and 39
characters long

Security Protocol

If you selected IPsec as the Access Control option,
select one of these security protocols:

ESP: to ensure the integrity of authentication and data,
and encrypt data

AH: to ensure the integrity of authentication and data; if
data encryption is prohibited, you can use IPsec

Algorithm Settings

Select the encryption algorithm settings for the security
protocol you selected

Combinations of Local Address (Scanner) and Remote Address (Host) on Group Policy
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Setting of Local Address (Scanner)
Setting of Remote IPv4 IPv6? Any addresses®
Address (Host)
IPv4' Yes — Yes
IPv6" 2 — Yes Yes
Blank Yes Yes Yes

' If you selected IPsec as the Access Control option, you cannot specify a prefix length

2 If you selected IPsec as the Access Control option, you can select a link-local address (fe80::), but the
group policy will be disabled.

3 You cannot use IPV6 link-local addresses.
Group Policy Guidelines

Service name Protocol type |Local/Remote port Controls these operations
number

Any — — All services

ENPC UDP 3289/Any port Searching for a product from

applications such as Epson Device
Admin and the scanner driver

SNMP ubP 161/Any port Acquiring and configuring MIB from
applications such as Epson Device
Admin and the scanner driver

WSD TCP Any port/5357 Controlling WSD

WS-Discovery UDP 3702/Any port Searching for a product from WSD

Network Scan TCP 1865/Any port Forwarding scan data from
Document Capture Pro

Network Push Scan | TCP Any port/2968 Acquiring job information on push
scanning from Document Capture
Pro

Network Push Scan |UDP 2968/Any port Searching for a computer from

Discovery scanner
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Service name Protocol type |Local/Remote port Controls these operations
number

HTTP (Local) TCP 80/Any port Forwarding Web Config and WSD

HTTPS (Local) TCP 443/Any port datatoa HTTP or HTTPS server

HTTP (Remote) TCP Any port/80 Firmware update and root certificate

HTTPS (Remote) TCP Any port/443 update on a HTTP or HTTPS client

Parent topic: Configuring IPsec/IP Filtering
IPsec/IP Filtering Configuration Examples
You can configure IPsec and IP filtering in a variety of ways, as shown in the examples here.

Receiving IPsec Packets Only

Use this example only for configuring a default policy.

* IPsec/IP Filtering: Enable

* Access Control: IPsec

* Authentication Method: Pre-Shared Key

* Pre-Shared Key: Enter a key up to 127 characters long

Receiving Scanning Data and Scanner Settings

Use this example to allow communication of scanning data and scanner settings from specified services.
Default policy:

» IPsec/IP Filtering: Enable

* Access Control: Refuse Access

Group policy:

* Enable this Group Policy: Check the box to enable

* Access Control: Permit Access

* Remote Address(Host): Client IP address

Method of Choosing Port: Service Name

+ Service Name: Select ENPC, SNMP, HTTP (Local), HTTPS (Local), and Network Scan
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Receiving Access from a Specified IP Address only

In these examples, the client will be able to access and configure the product in any policy configuration.
Default policy:

+ IPsecl/IP Filtering: Enable

* Access Control: Refuse Access

Group policy:

* Enable this Group Policy: Check the box to enable

+ Access Control: Permit Access

* Remote Address (Host): Administrator's client IP address

Note: Regardless of policy configuration, the client will be able to access and configure the scanner.

Parent topic: Configuring IPsec/IP Filtering
Configuring an IPsec/IP Filtering Certificate
You can configure a certificate for IPsec/IP traffic filtering using Web Config.
1. Access Web Config and select the Network Security tab.
2. Under IPsecl/IP Filtering, select Client Certificate.
3. Click Import to add a new client certificate and enter any necessary settings.

Note: If you have already imported a certificate published by a Certification Authority, you can copy
the certificate and use it in IPsec/IP Filtering. To copy, select the certificate from Copy From, and
then click Copy.

4. Click OK.

Parent topic: Configuring IPsec/IP Filtering

Related tasks
Accessing the Web Config Utility

Connecting the Product to an IEEE 802.1X Network

Follow the instructions in these sections to connect the product to an IEEE 802.1X network using Web
Config.

Configuring an IEEE 802.1X Network
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IEEE 802.1X Network Settings
Configuring a Certificate for an IEEE 802.1X Network

Parent topic: Using Your Product on a Secure Network
Configuring an IEEE 802.1X Network

If your product supports IEEE 802.1X, you can use it on a network with authentication provided by a
RADIUS server with a hub as an authenticator using Web Config.

1. Access Web Config and select the Network Security tab.
2. Under IEEE802.1X, select Basic.

3. Select the IEEE 802.1X setting options you want to use. To use the product on a Wi-Fi network, click
Wi-Fi Setup and select or enter an SSID.

4. Click Next.
You see a confirmation message.
5. Click OK.

Parent topic: Connecting the Product to an IEEE 802.1X Network

Related tasks
Accessing the Web Config Utility

IEEE 802.1X Network Settings
You can configure these IEEE 802.1X network settings in Web Config.

Setting Options/Description

IEEE802.1X (Wi-Fi) Displays the IEEE802.1X (Wi-Fi) connection status
Connection Method Displays the current network connection method

EAP Type Select one of these authentication methods for connections

between the product and a RADIUS server:

EAP-TLS or PEAP-TLS: You must obtain and import a CA-
signed certificate

PEAP/MSCHAPv2 or EAP-TTLS: You must configure a
password

User ID Enter an ID between 1 and 128 ASCII characters for
authentication on a RADIUS server
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Setting

Options/Description

Password

Enter a password between 1 and 128 ASCII characters for
authentication of the product. If you are using Windows as a
RADIUS server, enter up to 127 ASCII characters.

Confirm Password

Enter the authentication password again

Server ID

Enter a server ID between 1 and 128 ASCII characters for
authentication on a specified RADIUS server; server ID is
verified in the "subject/subjectAltName" field of a server
certificate sent from the RADIUS server

Certificate Validation

Select a valid certificate regardless of the authentication
method; import the certificate using the CA Certificate option

Anonymous Name

If you selected EAP-TTLS, PEAP-TLS or PEAP/MSCHAPv2
as the Authentication Method setting, you can configure an
anonymous name between 1 and 128 ASCII characters
instead of a user ID for phase 1 of a PEAP authentication

Encryption Strength

Select one of the following encryption strengths:
High for AES256/3DES
Middle for AES256/3DES/AES128/RC4

Parent topic: Connecting the Product to an IEEE 802.1X Network
Configuring a Certificate for an IEEE 802.1X Network
If your product supports IEEE 802.1X, you can configure a certificate for the network using Web Config.

1. Access Web Config and select the Network Security tab.
2. Under IEEE802.1X, select Client Certificate.
3. Click Import to add a new client certificate.

Note: If you have already imported a certificate published by a Certification Authority, you can copy
the certificate and use it in IEEE802.1X. To copy, select the certificate from Copy From, and then

click Copy.

4. Click OK.

Parent topic: Connecting the Product to an IEEE 802.1X Network
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Related tasks
Accessing the Web Config Utility

Using Epson Device Admin Configuration Software
Epson Device Admin is a multifunctional application that allows you to manage devices on a network.

With Windows, you can discover and monitor remote devices and use configuration templates to apply
unified settings to multiple scanners on a network, making it suitable for installing and managing multiple
scanners. See the Epson Device Admin help for instructions.

To install Epson Device Admin, download the software from the support page at epson.com/support
(U.S.), epson.ca/support (Canada), or latin.epson.com/support (Latin America) and follow the on-screen
instructions.

Parent topic: Using Your Product on a Secure Network
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Solving Problems

Check these sections for solutions to problems you may have using your product.

Note: Your product may differ from the images in this guide, but the instructions are the same unless
otherwise noted.

Scanner Light Status

Solving Scanning Problems

Solving Network Scanning Problems
Solving Scanned Image Quality Problems
Resetting the Epson Scan 2 Settings
Solving Flatbed Scanner Dock Problems
Solving Network Security Problems
Solving Digital Certificate Problems
Uninstall Your Product Software

Where to Get Help (U.S. and Canada)
Where to Get Help (Latin America)

Scanner Light Status

You can often diagnose problems with your scanner by checking its lights.
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DS-575W I

O 6 6 0 0o

“Zp AP mode light
= Wi-Fi light
! error light

O ready light

N O o AW DN

> slow mode light

W automatic feeding mode light

= double feed detection skip light

Light status

Condition/solution

The ! error light is flashing
slowly

A paper jam or a double feed has occurred. Remove any paper loaded
in the input tray. If the light continues to flash, a scanner error may have
occurred. Turn the scanner off and then back on again. If the error
continues, contact Epson for support.

The ! error light is on

The scanner cover is open. Make sure the scanner cover is closed and
there is no jammed paper inside.
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Light status

Condition/solution

The following lights are
flashing quickly:

* lerror

« Oready

« ZA AP mode (DS-575W II)
« 2= Wi-Fi (DS-575W II)

A fatal error has occurred. Try the following:

» Check the scanner connection to your computer to make sure it is
secure.

» Turn the scanner off and then back on again. If the error continues,
the scanner may be malfunctioning. Contact Epson for support.

The O ready light is off and
the following lights are on:

» lerror
« @ automatic feeding mode

« = double feed detection
skip

« > slow mode
« ZR AP mode (DS-575W II)
« = Wi-Fi (DS-575W II)

The firmware update has failed and the scanner is in recovery mode.
Try updating the firmware again.

The = Wi-Fiand ! error
lights are flashing slowly (DS-
575W 1)

The = Wi-Fi light is flashing
slowly and ! error light is on
(DS-575W 11)

An access point settings error (security error) has occurred. Press the
@ stop button to clear the error, restart the devices you want to connect
to the network, then reconnect to the network.

The = Wi-Fi (white) and
! error lights are flashing
slowly (DS-575W II)

A network connection error has occurred (the date and time have not
been set correctly). Reset the date and time in Web Config.

The & Wi-Fi and ZA AP
mode lights are flashing (DS-
575W 1)

The @ Wi-Fi connect and = Wi-Fi buttons are locked (Panel Lock)
and network settings cannot be configured. Set Panel Lock to Off in
Web Config. See the link at the end of this section for more details.

Parent topic: Solving Problems

Related references
Paper Jam Problems

173




Where to Get Help (U.S. and Canada)

Where to Get Help (Latin America)

Related tasks

Locking the Buttons on the Control Panel using Web Config
Related topics

Loading Originals

Wi-Fi Networking

Scanning

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.

Product Does Not Turn On or Turns Off Unexpectedly
Forgot the Administrator Password

Scanner Button Does Not Work as Expected
Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan 2

Paper Feeding Problems

Paper Jam Problems

Paper Protection Does Not Work Correctly

Scanning is Slow

Cannot Send Scans to an Email

Parent topic: Solving Problems

Product Does Not Turn On or Turns Off Unexpectedly
If the product does not turn on or if it turns off unexpectedly, try these solutions:
* Make sure the AC adapter is securely connected to the product and to a working electrical outlet.

« If the scanner turns off unexpectedly, you may need to adjust the AC power or AC adapter setting in
the Epson Scan 2 Utility.

Parent topic: Solving Scanning Problems

Related tasks
Changing the Power Off and Sleep Timer Settings
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Forgot the Administrator Password
If you forget the password or inadvertently set it, contact Epson for assistance.

Note: In most cases, the default password is the product's serial number. If there is a "Password" label
attached to the back of the product, enter the 8-digit number shown on the label. If there is no
"Password" label attached, enter the serial number on the label attached to the back of the product for
the initial administrator password. If you restore the product to default settings, the administrator
password resets to the initial setting.

Parent topic: Solving Scanning Problems

Related references
Notes on the Administrator Password

Scanner Button Does Not Work as Expected
If the scanner button does not start the correct program or perform the correct action, try these solutions:

+ Document Capture Pro (Windows) and Document Capture (Mac) do not support using the <> start
button to scan over a wireless connection (DS-575W Il). Connect the scanner using a USB cable or
launch Epson Scan 2 before scanning from the button on your scanner.

» Check that the correct scanner is selected using the Epson Scan 2 Utility.

* In Windows, be sure that the scanner is listed under Imaging Devices in the Device Manager.
» Make sure Document Capture Pro is installed correctly. If necessary, uninstall and reinstall it.

* Make sure you have assigned the correct job to the scanner button and change it, if necessary.
* Check the status of the lights and make sure the scanner is ready to scan.

* When using a wireless connection, start Epson Scan 2 on your computer before scanning from the
product (DS-575W II).

* Make sure Epson Scan 2 and other applications are installed correctly. If necessary, uninstall and
reinstall it.

Parent topic: Solving Scanning Problems

Related tasks
Adding and Assigning Scan Jobs with Document Capture Pro - Windows
Assigning Start Button Settings or Scan Jobs - Mac
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Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:

Make sure your computer has adequate memory and meets the system requirements for your
operating system.

Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart your scanning software.

Make sure the product is turned on.

Make sure the scanning software is installed.

Make sure the connection between the product and your computer is secure.

If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
In Windows, be sure that the product is listed under Imaging Devices in the Device Manager.
Check that the correct product is selected using the Epson Scan 2 Utility.

Check that the correct setting is assigned to the scanner button in Document Capture Pro (Windows)
or Document Capture (Mac).

Use the USB cable that came with the scanner.

Connect the product directly to the computer. The product may not work properly when connected
through a USB hub/switch.

If you are using a TWAIN-compliant program, make sure that the correct product is selected as the
Scanner or Source setting.

Check that the Wi-Fi connection is working correctly. Try turning the wireless router off and on (DS-
575W 1I).

If your scanner is connected to one computer via USB and another computer via wireless connection,
and Epson Scan 2 is running on the wirelessly connected computer, pressing the < start button on the
scanner will save the scanned images to the wirelessly connected computer (DS-575W II).

Parent topic: Solving Scanning Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements
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Cannot Start Epson Scan 2

If you cannot start Epson Scan 2, try these solutions:

Make sure your scanner appears in the Epson Scan 2 Utility.
Make sure your scanner is turned on and any interface cables are securely connected at both ends.

Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart Epson Scan 2.

Connect the scanner directly to the computer. The scanner may not work properly when connected
through a USB hub.

If you connected the scanner using a USB cable, make sure it is connected directly to your computer
or through only one USB hub.

If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.

If you are using a TWAIN-compliant program, make sure that the correct product is selected as the
Scanner or Source setting.

Make sure the ready light stops flashing, indicating that the scanner is ready to scan.

Parent topic: Solving Scanning Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements

Paper Feeding Problems
If you have problems feeding originals in your product, try these solutions:

If multiple pages feed at once, try the following:

* Remove the originals, fan the edges to separate the sheets, if necessary, and reload them.
» Load fewer originals at a time.

» Load only originals that meet the specifications for your product.

+ Clean inside the product and replace the roller assembly kit, if necessary.

» Check the pickup rollers and clean, if necessary.

« Press the 1™ slow mode button to slow down the scanning speed.
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+ Use Automatic Feeding Mode in Epson Scan 2 and scan originals one at a time.
+ Use the optional carrier sheet for thin, folded, or irregularly shaped originals.

 If you see a double feed error in the Epson Scan 2 window or the Document Capture Pro window, start
Epson Scan 2, select the Main Settings tab, select the Detect Double Feed setting, and select Off.

Note: On a Mac, only Epson Scan 2 displays double feed errors. Document Capture for Mac does not
include this setting.

Parent topic: Solving Scanning Problems

Related tasks
Cleaning Inside Your Scanner

Related topics
Loading Originals

Paper Jam Problems
If an original has jammed inside the product, follow these steps:

Note: The illustrations show the DS-575W I, but the instructions are the same for the DS-530 Il and DS-
770 1.

1. Turn off your product.
2. Remove all originals from the input tray.
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3. Pull down the cover open lever and open the scanner cover.
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5. Gently pull out any jammed originals from the output tray.

6. Close the scanner cover.

7. Carefully follow all loading instructions when you reload originals.

If originals jam in the product frequently, try the following:

+ Press the 1™ slow mode button to slow down the scanning speed.

» Turn off the Detect Double Feed setting.

» Clean inside the product and clean the rollers.

« If the roller counter is nearing end of life, replace the roller assembly Kkit.
Parent topic: Solving Scanning Problems

Related tasks
Cleaning Inside Your Scanner

Related topics
Loading Originals
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Paper Protection Does Not Work Correctly

To reduce damage to the original, the Paper Protection feature immediately stops scanning if a paper
feed error is detected. If the Paper Protection feature does not work correctly, try these solutions:

If your scanned original is damaged, make sure that the Paper Protection feature is enabled. Increase
the detection level, if necessary.

If misdetection occurs frequently, lower the Paper Protection detection level in the Epson Scan 2 Utility
(On-Medium is the default).

Turn the Paper Protection feature off in the Epson Scan 2 Utility (Scanner Setting > Paper
Protection > Off).

Note: Set the Paper Protection feature to Off when scanning plastic cards and thick originals.

When scanning multiple originals, make sure that the leading edges of the documents are aligned. If
the leading edges of the documents are not aligned, they may be mistakenly detected as a paper feed
error even if they are scanned correctly.

Make sure you align the edge guides with the original to avoid scanning at an angle.

Parent topic: Solving Scanning Problems

Scanning is Slow
If scanning becomes slow, try these solutions:

Scan your original at a lower resolution, if possible.

Make sure your system meets the requirements for your operating system. If you are scanning a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory or reduce the resolution.

Make sure you did not press the 1™ slow mode button to slow down the scanning speed.
The scanning speed may be reduced depending on the image adjustment features in Epson Scan 2.

If scanning becomes slower after scanning continuously with the ADF for a long time, the scanner may
have automatically slowed down to protect the scanner mechanism from overheating or becoming
damaged. Let the scanner rest with the power on for 30 minutes, then try scanning again.

Make sure slow mode is turned off.

If you are running virus protection or other security software, exclude the TWAIN.log files from
monitoring or set the TWAIN.log file as read only. See your virus protection or security software
instructions for details. The TWAIN.log file is saved in C:\Users\(user name)\AppData\Local\Temp.
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Note: You may need to unhide system folders to view files in that location.

« If you are scanning over a wireless network, factors such as interference, network traffic, or weak
signal strength may affect your scanning speed (DS-575W II).

* Computers with USB 3.0 (SuperSpeed) or USB 2.0 (Hi-Speed) ports can scan faster than those with
USB 1.1 ports. If you are using a USB 3.0 or 2.0 port with the scanner, make sure it meets the system
requirements.

Parent topic: Solving Scanning Problems

Related references
Windows System Requirements
Mac System Requirements

Cannot Send Scans to an Email
If you cannot send a scan to an email address (DS-575W 1), try these solutions:

* Make sure the destination email address is working.

* Make sure the email server settings are correct.

» Contact the email server administrator to make sure the server is running.

« If you are using Microsoft Exchange, check the following:

If you are unable to sign in, your Entra ID may be blocked by a conditional access policy. Check
your conditional access policies with Entra ID. For detailed instructions, see the "Microsoft Learn"
site.

If you cannot send email and you see a message telling you to sign in to your email service and
contact your administrator, check Web Config for the current status.

Select the Network tab > Email Server > Basic.

If the email server status is Signed in, the sign-in information may not have been saved to the
product. Click OK to send the setting information to the product.

If there is no status and the Sign In button is displayed, sign in.

The cloud service or email service may not be connected, or the connection has expired. Connect to
the cloud service or e-mail service.

You may need to sign in to the cloud service again. Sign in to the cloud service.

An expiration message may be displayed if you signed in and a certain period of time has passed
without using the email sending function. If a product using OAuth 2.0 authentication has not been
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used for an extended period, or the email-sending function has not been used, the access token
and refresh token become invalid. The administrator should sign in again.

Parent topic: Solving Scanning Problems

Related tasks
Setting Up OAuth 2.0 Authentication

Solving Network Scanning Problems
Check these solutions if you have problems scanning over a network (DS-575W II).

Cannot Scan Over a Network
Product Cannot Connect to a Wireless Router or Access Point

Parent topic: Solving Problems

Cannot Scan Over a Network
If you have problems scanning over a network, try these solutions:

Move the scanner and computer or smart device closer to the access point.

If you cannot scan from the < start button on the scanner, make sure you restarted your computer
after installing the scanning software. Also start Epson Scan 2 before scanning with the <> start button.

Document Capture Pro (Windows) and Document Capture (Mac) do not support starting a scan from
the scanner button over a wireless network. Launch Epson Scan 2 before scanning from the scanner
button over a network.

If you are scanning a large original at a high resolution, a network communication error may occur. Try
scanning again at a lower resolution.

If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few
seconds, and restart the program. If Epson Scan 2 cannot restart, turn off your scanner, turn it back
on, and try starting the program again.

Check the network connection setting in the Epson Scan 2 Utility.

You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

If you see the message "Network product is not available: currently being used by user", there may be
a communication error between the scanner and computer. Restart the scanner.

If the Firewall function is active, the scanner may not be discovered by the Epson Scan 2 Utility. Open
the Epson Scan 2 Utility, enter the IP address for your scanner, and click Add.
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If the scanner and computer cannot communicate and are connected to the same network (subnet or
VLAN), check if your router uses the privacy separator and disable it, if necessary. Follow the
instructions in your router documentation to disable the privacy separator.

Parent topic: Solving Network Scanning Problems

Related topics
Wi-Fi Networking

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

If you are connecting the product via Wi-Fi Protected Setup (WPS), make sure you activate WPS on
your product within 2 minutes of activating WPS discovery mode on the router by pressing the WPS
button or enabling the WPS setting in your router firmware.

Make sure to place your product within contact range of your router or access point. Avoid placing
your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing
cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions. Be sure to connect your scanner only to a 2.4 GHz network name (SSID).

Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

You may need to temporarily disable your firewall and any anti-virus software on your wireless router
or access point. Then try scanning again. You can also unblock your product driver or network
address in your firewall or anti-virus software.

Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, check the label on the back or bottom of your product. Then
follow the instructions in your router or access point documentation to add the address to the list.

If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.
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» Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

* The product may not be able to communicate with a computer with both Ethernet and Wi-Fi adapters
enabled. Disable all network interfaces except for the interface connected to the product.

» Enable the DHCP function on the router or access point.
» Check that the product's IP address is set correctly.
Parent topic: Solving Network Scanning Problems

Related topics
Wi-Fi Networking

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.

Note: For solutions when using Document Capture Pro (Windows) or Document Capture (Mac)
software, see the Document Capture Pro (Windows) or Document Capture (Mac) help utility.

Back of Original Image Appears in Scanned Image

Scanned Characters are Blurry

Characters are not Recognized During Conversion to Editable Text (OCR)
Ripple Patterns Appear in an Image

Spots or Lines Appear in All Scanned Images

Scanned Image is Cropped

Parent topic: Solving Problems

Back of Original Image Appears in Scanned Image

If an image from the back of a thin original appears in your scanned image, make sure you selected the
correct Image Type setting for your original and select the Text Enhancement setting in Epson Scan 2.
You can also select the Remove Background setting in Epson Scan 2.

Note: If you select Color as the Image Type setting, you can change the level from Standard to High to
remove more of the background.

Parent topic: Solving Scanned Image Quality Problems
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Related references
Image Format Options

Related tasks
Scanning in Epson Scan 2

Scanned Characters are Blurry
If characters in your scanned images are blurry, try these solutions:
» Make sure you do not move the product or original while scanning.
» Operate the product on a flat, stable surface.
» Make sure the originals are ejecting properly.
» Adjust these Epson Scan 2 settings (if available) and try scanning again:
+ Select the Text Enhancement setting.

+ Ifthe Image Type setting is Black & White, adjust the Threshold setting or change the Edge
Enhancement and Noise Reduction Level settings.

* Increase the Resolution setting.
+ Setthe Image Type to Grayscale.

* If you are scanning in JPEG format, change the compression level. Click Options in the Image
Format menu and change the Image Quality setting.

Parent topic: Solving Scanned Image Quality Problems

Related references
Image Format Options

Related tasks
Scanning in Epson Scan 2

Characters are not Recognized During Conversion to Editable Text (OCR)
If characters in your scanned images are not recognized during OCR conversion, try these solutions:
» Make sure your original is loaded straight on your product.
» Use an original with clear text.
» Adjust these Epson Scan 2 settings (if available) and try scanning again:
+ Select the correct Image Type setting.
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+ Select or adjust the Text Enhancement setting.
+ Ifthe Image Type is set to Black & White, adjust the Threshold setting.
+ Setthe Image Type to Grayscale.
» Set the scanning resolution between 200 and 600 dpi.
« If the original document is in landscape mode, set the Rotate setting to Auto in Epson Scan 2.
 If you are using OCR software, check the manual for any additional adjustments.
» Scan thermal paper receipts as soon as possible. They may deteriorate due to age or friction.

* When saving to Microsoft Office or Searchable PDF files, check that the correct languages are
selected. Check the language in each save setting window.

» Some font types may cause recognition errors. If the original font cannot be changed, you may need to
manually edit the unrecognized text.

Parent topic: Solving Scanned Image Quality Problems

Related references
Image Format Options

Related tasks
Scanning in Epson Scan 2

Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:

» Select the Descreening setting on the Advanced Settings tab.
» Select a lower Resolution setting.
Parent topic: Solving Scanned Image Quality Problems

Related references
Image Format Options

Related tasks
Scanning in Epson Scan 2
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Spots or Lines Appear in All Scanned Images
If spots or lines appear in all your scanned images, try the following solutions:

Clean the rollers and glass scanning surfaces inside your product using a genuine Epson cleaning kit
or a soft, moist cloth.

Remove any dirt from your original.
Enable the Detect Glass Dirt setting in the Epson Scan 2 Ultility.
Note: If glass dirt detection does not work correctly, adjust the setting. If the glass dirt alert screen

appears after cleaning the inside of the product, check the glass surface again (scratches on the glass
may be detected as a glass dirt).

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Cleaning Inside Your Scanner

Scanned Image is Cropped
If the edges of a scanned image are cropped, try the following solutions:

Select Auto Detect or Auto Detect (Long Paper) as the Document Size setting in Epson Scan 2,
Document Capture Pro, or Document Capture.

If the document size is not detected correctly using the Auto Detect setting, select the size of your
original from the Document Size list.

Note: If the size you want to scan is not on the list, select Customize to create it manually (Windows
only).

In Epson Scan 2, select the Main Settings tab. Select Document Size > Settings and adjust the
cropping area shown in the Crop Margins for Size "Auto" setting.

In Epson Scan 2, select the Advanced Settings tab. Make sure the Edge Fill setting is set to None.

Parent topic: Solving Scanned Image Quality Problems
Related tasks

Scanning in Epson Scan 2

Scanning with Simple Scan in Document Capture Pro - Windows
Scanning with Job Scan in Document Capture Pro - Windows
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Scanning with Document Capture - Mac

Resetting the Epson Scan 2 Settings

If you continue to experience image quality problems after trying all possible solutions, you may need to
reset the Epson Scan 2 settings using the Epson Scan 2 Utility.

1. Do one of the following to start the Epson Scan 2 Ultility:

* Windows 10: Click ﬂ > EPSON > Epson Scan 2 Utility.
* Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

* Windows (other versions): Click L or Start, and select All Programs or Programs. Select
EPSON > Epson Scan 2 > Epson Scan 2 Utility.

* Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2
Utility.

2. Click the Other tab.
3. Click Reset and confirm your choice.

Note: If resetting the Epson Scan 2 settings does not solve your problem, uninstall Epson Scan 2 and re-
install it.

Parent topic: Solving Problems

Solving Flatbed Scanner Dock Problems

Check these solutions if you have problems scanning with the optional flatbed scanner dock (DS-530
[I/DS-770 11).

Scanned Image Edges are Cropped
Line of Dots Appears in All Scanned Images
Back of Original Image Appears in Scanned Document

Parent topic: Solving Problems

Scanned Image Edges are Cropped

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.

In the Epson Scan 2 settings, set the Edge Fill setting to None.
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Parent topic: Solving Flatbed Scanner Dock Problems

Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, try these solutions:

* Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the
cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

» Make sure any interface cables are securely connected at both ends.

* Remove any dust or dirt that may have adhered to your original.

* Do not press with too much force on the original or the document cover.

» Keep the document cover closed to prevent dirt or dust from getting inside.
Parent topic: Solving Flatbed Scanner Dock Problems

Back of Original Image Appears in Scanned Document
If an image from the back of a thin original appears in your scanned image, try the following solutions:
» Place a piece of black paper on the back of the original and scan it again.

» Make sure you selected the correct Image Type setting for your original and select the Text
Enhancement setting in Epson Scan 2. You can also select the Remove Background setting in
Epson Scan 2.

» Adjust the Brightness setting in Epson Scan 2.
Parent topic: Solving Flatbed Scanner Dock Problems

Related references
Image Format Options

Related tasks
Scanning in Epson Scan 2

Solving Network Security Problems
Check these sections if you have problems using the network security features (DS-575W ).

Pre-Shared Key was Forgotten
Cannot Communicate with the Product Using IPsec Communication
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Communication was Working, but Stopped
Cannot Connect After Configuring IPsec/IP Filtering
Cannot Access the Product After Configuring IEEE 802.1X

Parent topic: Solving Problems

Pre-Shared Key was Forgotten

If you forget a pre-shared key, change the key using Web Config for the default or group policy.

Parent topic: Solving Network Security Problems

Cannot Communicate with the Product Using IPsec Communication

Make sure your computer is using one of these supported algorithms for communicating with the

product:

Security method

Supported algorithms

IKE encryption algorithm

AES-CBC-128, AES-CBC-192, AES-CBC-256, AES-GCM-128*, AES-
GCM-192*, AES-GCM-256*, 3DES

IKE authentication
algorithm

SHA-1, SHA-256, SHA-384, SHA-512, MD5

IKE key exchange

DH Group1, DH Group2, DH Group5, DH Group14, DH Group15, DH

AH authentication
algorithm

algorithm Group16, DH Group17, DH Group18, DH Group19, DH Group20, DH
Group21, DH Group22, DH Group23, DH Group24, DH Group25, DH
Group26, DH Group27*, DH Group28*, DH Group29*, DH Group30*

ESP encryption algorithm |[AES-CBC-128, AES-CBC-192, AES-CBC-256, AES-GCM-128, AES-
GCM-192, AES-GCM-256, 3DES

ESP authentication SHA-1, SHA-256, SHA-384, SHA-512, MD5

algorithm

* Available for IKEv2 only

Parent topic: Solving Network Security Problems
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Communication was Working, but Stopped

If network communication was working, but suddenly stopped, the product's and/or computer's IP
address may have changed or is invalid. Try these solutions:

« If DHCP is out of date, or the IPv6 address is out of date or was not obtained, you may not be able to
find the IP address registered in Web Config.

« If the product has been unplugged for a long time, the date and time settings may be incorrect,
creating an error with the certificate. Make sure the product's date and time settings are correct. If that
does not solve the problem, restore the network settings to default from the product's control panel
and then set your network settings again.

« If that does not solve the problem, enter a static IP address using Web Config.
Parent topic: Solving Network Security Problems

Cannot Connect After Configuring IPsec/IP Filtering

The set value may be incorrect. Connect from the computer and configure the IPsec/IP Filtering settings
again.

Parent topic: Solving Network Security Problems

Related tasks
Determining the Scanner's IP Address
Accessing the Web Config Utility

Cannot Access the Product After Configuring IEEE 802.1X

If you cannot access the product after configuring it for IEEE 802.1X, reset the network settings from the
product's control panel. Connect the product and computer, set the network settings again, and then
configure IEEE802.1X.

Parent topic: Solving Network Security Problems

Related tasks
Restoring Default Network Settings

Solving Digital Certificate Problems
Check these sections if you have problems using a digital certificate (DS-575W I1).

Digital Certificate Warning Messages
Cannot Import a Digital Certificate
Cannot Update a Certificate or Create a CSR
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Deleted a CA-signed Certificate
Parent topic: Solving Problems

Digital Certificate Warning Messages

If you see a warning message when using a digital certificate, check for solutions in this table.

Message

Solution

Enter a Server Certificate.

Select a certificate file and click Import.

CA Certificate 1 is not entered.

Import CA certificate 1 before importing additional
certificates.

Invalid value below.

Remove any unsupported characters in the file
path and password.

Invalid date and time.

Set the date and time on the product using Web
Config, EpsonNet Config, or the product control
panel.

Invalid password.

Enter the password that matches the password set
for the CA certificate.

Invalid file.

Try the following:

» Import only certificate files in X509 format sent
by a trusted certificate authority.

* Make sure the file size is 5KB or less and is not
corrupted or fabricated.

* Make sure the chain in the certificate is valid;
check the certificate authority's website.

Cannot use the Server Certificates that include
more than three CA certificates.

Import certificate files in PKCS#12 format that
contains one or two CA certificates, or convert
each certificate to PEM format and import them
again.

The certificate has expired. Check if the certificate
is valid, or check the date and time on your
product.

Make sure the product time and date are set
correctly and, if the certificate is out of date, obtain
and import a new certificate.
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Message Solution

Private key is required. Do one of the following to pair a private key with
the certificate:

» For PEM/DER format certificates obtained from
a CSR using a computer, specify the private key
file.

+ For PKCS#12 format certificates obtained from
a CSR using a computer, create a file containing
the private key.

If you re-imported a PEM/DER format certificate
obtained from a CSR using Web Config, you can
only import it once. You must obtain and import a
new certificate.

Setup failed. Make sure the computer and product are
connected, and the certificate file is not corrupted,
then import the certificate file again.

Parent topic: Solving Digital Certificate Problems

Cannot Import a Digital Certificate
If you cannot import a digital certificate, try these solutions:

* Make sure the CA-signed certificate and the CSR have the same information. If they do not match,
import the certificate to a device that matches the information or use the CSR to obtain the CA-signed
certificate again.

» Make sure the CA-signed certificate file size is 5KB or less.
* Make sure you are entering the correct password.
Parent topic: Solving Digital Certificate Problems

Cannot Update a Certificate or Create a CSR

If you cannot update a self-signed certificate or create a CSR for a CA-signed certificate, try these
solutions:

» Make sure that you entered a Common Name setting in Web Config.

* Make sure the Common Name setting does not contain unsupported characters or is divided by a
comma. Correct the setting and update the certificate again.
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Parent topic: Solving Digital Certificate Problems

Deleted a CA-signed Certificate
If you accidentally deleted a CA-signed certificate, try these solutions:
« If you retained a backup file, import the CA-signed certificate again.

* If you obtained the certificate using a CSR created in Web Config, you cannot import a deleted
certificate. Create a new CSR and obtain a new certificate.

Parent topic: Solving Digital Certificate Problems

Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - Mac

Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Exit all applications currently running on your computer.
2. Turn off the product.
3. Disconnect any interface cables.
4. Do the following to uninstall each of your scanning software programs and follow any on-screen
instructions:

* Windows 11: Click , then search for Settings and select it. Select Apps or System > Apps &
features. Then select the program you want to uninstall and select Uninstall.

* Windows 10: Click Iﬂ and select k=4 (Settings) > Apps > Apps & features. Select the product
software program and click Uninstall.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the product software program and click Uninstall/Change.

* Windows 7: Open the Windows Control Panel utility. Select Programs and Features. (In
Classic view, select Programs and click Uninstall a program.) Select the product software
program and click Uninstall/Change.
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5.

Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - Mac

In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

1.

o s~ b

6.
7.
8.

To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or
latin.epson.com/support (Latin America) and select your product.

Follow the instructions on the screen to install the Uninstaller utility.
Quit all applications currently running on your Mac.
Double-click the Uninstaller icon.

In the Epson Uninstaller screen, select the checkbox for each software program you want to
uninstall.

Click Uninstall.
Follow the on-screen instructions to uninstall the software.
To reinstall your product software, see the Start Here sheet for instructions.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Where to Get Help (U.S. and Canada)

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) and select
your product for solutions to common problems with your product. You can download utilities and
documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.
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Speak to a Support Representative

Before you call Epson for support, please have the following information ready:
* Product name

* Product serial number (located on a label on the product)

» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration

» Description of the problem

Then call:

» U.S.:(5662) 276-4300, 7 AM to 4 PM, Pacific Time, Monday through Friday

+ Canada: (905) 709-3839, 7 AM to 4 PM, Pacific Time, Monday through Friday
Dayls and hours of support are subject to change without notice. Toll or long distance charges may
apply.

Note: For help using any other software on your system, see the documentation for that software for
technical support.

Purchase Supplies and Accessories

You can purchase genuine Epson accessories at epson.com (U.S. sales) or epson.ca (Canadian sales).
You can also purchase accessories from an Epson authorized reseller. To find the nearest one, call 800-
GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Parent topic: Solving Problems

Where to Get Help (Latin America)

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson's support website at latin.epson.com/support and select your product for solutions to
common problems with your product. You can download utilities and documentation, get FAQs and
troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

* Product name
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* Product serial number (located on a label on the product)

» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration
» Description of the problem

Then call:
Country Telephone
Argentina (54 11) 5167-0300
0800-288-37766
Bolivia* 800-100-116
Brazil State capitals and metropolitan areas: 3004-6627
Other areas: 0800-377-6627 / 0800-EPSONBR
Chile (56 2) 2484-3400
Colombia Bogota: 601 602-4751
Other cities: 01-8000-915235
Costa Rica 800-377-6627

Dominican Republic*

1-888-760-0068

Ecuador*® 1-800-000-044

El Salvador* 800-6570

Guatemala* 1-800-835-0358

Mexico Mexico City: (52 55) 1323-2052
Other cities: 800-087-1080

Nicaragua* 00-1-800-226-0368

Panama* 00-800-052-1376

Paraguay 009-800-521-0019

Peru Lima: (51 1) 418-0210
Other cities: 0800-10126

Uruguay 00040-5210067
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* Contact your local phone company to call this toll-free number from a mobile phone.

If your country does not appear in the list, contact the sales office in the nearest country. Toll or long
distance charges may apply.

Note: For help using any other software on your system, see the documentation for that software for
technical support.
Purchase Supplies and Accessories

You can purchase genuine Epson accessories from an Epson authorized reseller. To find the nearest
reseller, visit latin.epson.com or call your nearest Epson sales office.

Parent topic: Solving Problems
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Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S.) or
this site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements

Mac System Requirements

General Specifications

Dimension Specifications

Electrical Specifications

Environmental Specifications

Flatbed Scanner Dock Specifications (DS-530 11/DS-770 Il)
Network Interface Specifications (DS-575W II)

Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating
systems:

* Windows 11

* Windows 10
* Windows 8.x
* Windows 7

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.), epson.ca/support (Canada), or latin.epson.com/support (Latin America),
select your product, and select Downloads.

Parent topic: Technical Specifications
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Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
* macOS 11.x or newer
*+ macOS 10.15.x
* macOS 10.14.x
* macOS 10.13.x
* macOS 10.12.x
+ OS X 10.11.x
+ OS X 10.10.x
+ OS X 10.9.x
+ OSX10.8.x
+ 0OSX10.7.5

Note: The UNIX File System (UFS) for OS X and Fast User Switching on OS X is not supported.

For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.), epson.ca/support (Canada), or latin.epson.com/support (Caribbean), select
your product, and select Downloads.

Parent topic: Technical Specifications

General Specifications

Scanner type Sheet feed, one pass duplex, color
Photoelectric device CIS
Effective pixels 5100 x 9300 pixels at 600 dpi
2550 x 64,500 pixels at 300 dpi
Document size Maximum: 8.5 x 240 inches (215.9 x 6096 mm)
Minimum: 2 x 2 inches (50.8 x 50.8 mm)
Paper input Facedown loading
Paper output Facedown ejection
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Paper capacity DS-530 1II/DS-575W II:
50 sheets of paper at 21 Ib (80 g/m?) weight
DS-770 Il
100 sheets of paper at 21 Ib (80 g/m?) weight

Scanning resolution 600 dpi (main scan)
600 dpi (sub scan)
Output resolution 50 to 1200 dpi in 1 dpi increments

53 inches (1346.0 mm) or less: up to 600 dpi

215 inches (5461.0 mm) or less: up to 300 dpi

240 inches (6096.0 mm) or less: up to 200 dpi
Color Depth Color:

30 bits per pixel internal (10 bits per pixel per color)

24 bits per pixel external (8 bits per pixel per color)

Grayscale:

10 bits per pixel internal

8 bits per pixel external

Black-and-white:

10 bits per pixel internal

1 bit per pixel external

Interface’ SuperSpeed USB 3.0 (backward-compatible with USB 1.1)
IEEE802.11b/g/n (DS-575W II)
Light source RGB LED

* You cannot use a USB and network connection at the same time (DS-575W II).
Parent topic: Technical Specifications

Dimension Specifications

Height 6.9 inches (176 mm)
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Width 11.7 inches (296 mm)
Depth 6.7 inches (169 mm)
Weight 8.21b (3.7 kg)

Note: Dimensions do not include projecting parts.

Parent topic: Technical Specifications
Electrical Specifications

Scanner

Note: Check the label on the scanner and the AC adapter for voltage information. Power consumption
varies depending on operating conditions or whether an option is installed.

Rated DC input power supply DC 24V
voltage

Rated DC input current 1A
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Power consumption

AC Adapter

AC adapter model
Rated input current
Rated frequency range

Rated output power supply
voltage

Rated output current

DS-530 1I/DS-770 1l

Operating: 11 W (approximate) (DS-530 II)
12 W (approximate) (DS-770 I1)
Ready mode: 5.4 W (approximate)
Sleep mode: 1.0 W (approximate)
Power off mode: 0.1 W (approximate)
DS-575W I

USB Connection:

Operating: 11 W (approximate)
Ready mode: 5.4 W (approximate)
Sleep mode: 1.0 W (approximate)
Power off mode: 0.1 W (approximate)
Wi-Fi Connection:

Operating: 12 W (approximate)
Ready mode: 5.5 W (approximate)
Sleep mode: 1.3 W (approximate)
Power off mode: 0.1 W (approximate)

100 to 240 V model: A461H
1A

50 to 60 Hz

DC24V

1A

Parent topic: Technical Specifications

204



Environmental Specifications

Temperature Operating: 41 to 95 °F (5 to 35 °C)
Storage: —13 to 140 °F (-25 to 60 °C)

Humidity Operating: 15t0 80% RH

(non-condensing) Storage: 15 to 85% RH

Operating conditions Ordinary office or home conditions

Note: Avoid operating the scanner in direct sunlight, near a strong light source, or in extremely dusty
conditions.

Parent topic: Technical Specifications

Flatbed Scanner Dock Specifications (DS-530 1I/DS-770 II)

Interface Hi-Speed USB

Rated DC input power supply DC 24V

voltage

Dimensions Width: 11.8 inches (300 mm)

(when assembled with a sheet ~ Depth: 18.9 inches (481 mm)

feed scanner and a flatbed Height 9.6 inches (245 mm)

scanner)

Weight Approximately 2.4 1b (1.1 kg)

Temperature Operating: 50 to 95 °F (10 to 35 °C)
Storage: —4 to 140 °F (=20 to 60 °C)

Humidity Operating: 20 to 80%

(non-condensing) Storage: 20 to 85%

Parent topic: Technical Specifications
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Network Interface Specifications (DS-575W lIl)

Wi-Fi

Wireless LAN standard IEEE802.11 b/g/n

Wireless security WPA2-PSK (AES); WPA2 compliant support for WPA/WPA2
Personal
WPA2-Enterprise; WPA2 compliant with support for WPA/WPA2
Enterprise
WEP (64/128 bit)

Frequency range 2.4 GHz

Communication mode Infrastructure mode

Ad hoc mode; not supported for IEEE802.11n
AP mode; not supported for IEEE802.11b

Radio frequency power Maximum 20 dBm (EIRP)
transmitted

Note: AP mode and Wi-Fi connection can be used at the same time.

206



Security Protocol

SSL/TLS

Authentication for email sending

MIB accessing
Authentication/Encryption

HTTPS (Server/Client)

SMTPS (Client)

STARTTLS

Root certificate (Client)

Root certificate updating (Client)

CA-signed certificate (Server)

CA certificate (Server)

CSR generation (Server)

Self-signed certificate (Server)

EC key CSR/self-signed certificate generation (Server)
Certificates/Secret key imports (Server)

POP before SMTP, APOP, SMTP Authentication
SNMPv3

Parent topic: Technical Specifications

Safety and Approvals Specifications

Scanner

United States
Canada

AC Adapter (A461H)

United States

Canada

EMC: FCC part 15 Subpart B class B
EMC: CAN ICES-3 (B)/NMB-3 (B)

Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Safety: CAN/CSA C22.2 No. 60950-1
EMC: CAN ICES-3 (B)/NMB-3 (B)
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Optional Flatbed Scanner Dock (DS-530 Il/DS-770 Il)

United States EMC: FCC part 15 Subpart B class B
Canada EMC: CAN/CSA-CEV/IEC CISPR 22 class B

This equipment contains the following wireless module: (DS-575W 1)
» Manufacturer: FOXCONN ELECTRONICS INC.
* Type: J26H006

This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).

Notice for Argentina

CN @ CNC ID: C-20841

Notice for Mexico

Operation is subject to the following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause
undesired operation of the device.

Product model: J382E (DS-575W II)
Brand: EPSON
IFT Certification Number: RCPEPJ218-0025
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Notice for Paraguay

Imported by:

Fastrax, S.A.

Av. Peru esq. Rio de Janeiro, Barrio Las Mercedes, Asuncién, Paraguay
Imported by:

Sol Control S.R.L.

Av. Gral. Bernardino Caballero 810 esq. Celsa Speratti, Asuncion, Paraguay

Notice for Peru

Product Model: DS-575W Il (J382E)

Brand: EPSON

This product uses the following WLAN module:

WLAN Module Model: J26H006

FCC ID: BKMFBJ26H006

Product Manufacturer: Seiko Epson Corporation

Address: 3-3-5 Owa Suwa-shi, Nagano-Ken 392-8502, Japan
Parent topic: Technical Specifications
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Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S.) or
this site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions

Restrictions on Copying

Default Delay Times for Power Management for Epson Products
Binding Arbitration and Class Waiver

Trademarks

Copyright Notice

Important Safety Instructions
Follow these safety instructions when setting up and using the product.

Read all these instructions, and follow all warnings and instructions marked on the product.
Place the product close enough to the computer for the interface cable to reach it easily.

Do not place or store the product outdoors, in a car, near excessive dirt or dust, water, heat sources,
or in locations subject to shocks, vibrations, condensation, high temperature or humidity, direct
sunlight, strong light sources, or rapid changes in temperature or humidity.

Do not use with wet hands.

When connecting this product to a computer or other device with a cable, ensure the correct
orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

Do not insert objects into any opening as they may touch dangerous voltage points or short out parts.
Beware of electrical shock hazards.

Place the product on a flat, stable surface that extends beyond the base of the product in all directions.
If you place the product by the wall, leave at least 3.9 inches (10 cm) between the back of the product
and the wall.

After replacing consumable parts, dispose of them correctly following the rules of your local authority.
Do not disassemble them.
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Never disassemble, modify, or attempt to repair the product or a product option by yourself except as
specifically explained in this guide.

Caution: Radio waves from this product may adversely affect the operation of medical equipment,
airplanes, or automatically controlled devices, such as pacemakers, automatic doors, or fire alarms.
When using this product near such devices or inside a medical facility, follow the directions from
authorized staff members at the facility, and follow all posted warnings and directions on the device to
avoid causing an accident (DS-575W II).

AC Adapter

Do not place or store the AC adapter outdoors, in a car, near excessive dirt or dust, water, heat
sources, or in locations subject to shocks, vibrations, condensation, high temperature or humidity,
direct sunlight, strong light sources, or rapid changes in temperature or humidity.

Place the product and the AC adapter near an electrical outlet where the adapter can be easily
unplugged.

The AC power cord should be placed to avoid abrasions, cuts, fraying, crimping, and kinking.

Do not place objects on top of the AC power cord and do not allow the AC adapter or the power cord
to be stepped on or run over. Be particularly careful to keep the AC power cord straight at the end and
the point where it enters the AC adapter.

Use only the AC adapter that comes with your product. Using any other adapter could cause fire,
electrical shock, or injury.

Use only the power cord that comes with your product. Use of another cord may cause fires or shock.
Do not use the cord with any other equipment.

The AC adapter is designed for use with the product with which it was included. Do not attempt to use
it with other electronic devices unless specified.

Use only the type of power source indicated on the AC adapter's label, and always supply power
directly from a standard domestic electrical outlet with the AC adapter that meets the relevant local
safety standards.

Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on
and off.

If you use an extension cord with the product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.
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* Never disassemble, modify, or attempt to repair the AC adapter by yourself except as specifically
explained in the product's guides.

+ If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in
the plug, make sure you replace them with fuses of the correct size and rating.

» Unplug the product and the AC adapter, and refer servicing to qualified service personnel under the
following conditions: The AC adapter or plug is damaged; liquid has entered the product or the AC
adapter; the product or the AC adapter has been dropped or the case has been damaged; the product
or the AC adapter does not operate normally or exhibits a distinct change in performance. (Do not
adjust controls that are not covered by the operating instructions.)

* Unplug the product and the AC adapter before cleaning. Clean with a damp cloth only. Do not use
liquid or aerosol cleaners.

« If you are not going to use the product for a long period, be sure to unplug the AC adapter from the
electrical outlet.
USB

» Use only the USB cable supplied with your product. Using any other USB cable could cause fire,
electrical shock, or injury.

* The USB cable is designed for use with the product with which it was included. Do not attempt to use it
with other electrical devices unless specified.

» The USB cable should be placed to avoid abrasions, cuts, fraying, crimping, and kinking.

» Do not place objects on top of the USB cable and do not allow the cable to be stepped on or run over.
Be particularly careful to keep the USB cable straight at the end.

+ If you are not going to use the product for a long period, unplug the USB cable from the computer.

* Unplug the product and the USB cable, and refer servicing to qualified service personnel under the
following conditions: Liquid has entered the product; the product has been dropped or the case has
been damaged; the product does not operate normally or exhibits a distinct change in performance.
(Do not adjust controls that are not covered by the operating instructions.)

Parent topic: Notices

Restrictions on Copying
Observe the following restrictions to ensure responsible and legal use of your scanner.
Copying of the following items is prohibited by law:

* Bank bills, coins, government-issued marketable securities, government bond securities, and
municipal securities
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* Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage
» Government-issued revenue stamps, and securities issued according to legal procedure
Exercise caution when copying the following items:

» Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes,
concession tickets, etc.

» Passports, driver's licenses, warrants of fitness, road passes, food stamps, tickets, etc.
Note: Copying these items may also be prohibited by law.

Restriction on disassembling and decompiling

You may not disassemble, decompile, or otherwise attempt to derive the source code of any software
included with this product.

Parent topic: Notices

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.

Parent topic: Notices

Binding Arbitration and Class Waiver

1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6, that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.
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1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3131 Katella Ave., Los
Alamitos, CA 90720 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAlLegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.

1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.

1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling
1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a
single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the
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selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not
any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising
out of or relating to the interpretation, applicability, enforceability or formation of this Agreement,
including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad
delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or
cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1
above. The arbitrator shall be empowered to grant whatever relief would be available in a court under
law or in equity. The arbitrator may award you the same damages as a court could, and may award
declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent
necessary to provide relief warranted by that party's individual claim. In some instances, the costs of
arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration
than in court. The arbitrator's award is binding and may be entered as a judgment in any court of
competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:

(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").

(i) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
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agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section
1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.

1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).

1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.

Parent topic: Notices

Trademarks

EPSONP® and Epson Smart Panel® are registered trademarks and Perfection™ is a trademark of Seiko
Epson Corporation.

Apple, App Store, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other
countries.

Android and Google are registered trademarks and Google Play is a trademark of Google LLC.
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Microsoft and Windows are trademarks of the Microsoft group of companies.
Wi-Fi® is a registered trademark of Wi-Fi Alliance®.

General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

EPSON

Parent topic: Notices

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. No patent liability is assumed with
respect to the use of the information contained herein. Neither is any liability assumed for damages
resulting from the use of the information herein. The information contained herein is designed only for
use with this Epson product. Epson is not responsible for any use of this information as applied to other
products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser or lessee of this product
or third parties for damages, losses, costs, or expenses incurred by purchaser or lessee or third parties
as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or
alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson
Corporation's operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from
the use of any options or any consumable products other than those designated as Original Epson
Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.

The contents of this manual and the specifications of this product are subject to change without notice.

libTIFF Software Acknowledgment
A Note Concerning Responsible Use of Copyrighted Materials
Copyright Attribution

Parent topic: Notices
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libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (1) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Copyright Attribution
© 2026 Epson America, Inc.
4/26
CPD-59609R1
Parent topic: Copyright Notice
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